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Introduction

Figure 1: Jessica Labatte. Bleeding Heart, 2018. Archival pigment print. 20 x 25 in. (Copyright; Jessica Labatte)

Image Description: A still life photo of an old blue birdhouse with a green roof with the paint peeling off in front of a mint
green vase of bleeding heart flowers with green leaves and branches with white flowers.

Photography has long been thought of as an accurate representation of the world. A tension, nonetheless, exists between
photography as factual record and as constructed image. We will explore this tension in the introductory digital photography
course. Students will learn the basic functions of digital single-lens reflex (DSLR) cameras and how to use them to create
photographic images. Completion of photography exercises helps students practice specific technical skills, and a presentation on a
photographic artist provides the opportunity to learn information literacy skills. In other assignments, students explore the two
different approaches to photography (taking versus making a photograph), hone their visual literacy skills, and consider how
process and technique reflect conceptual ideas. The goal is to create images that exhibit a relationship between the concept and the
formal elements of aesthetics.

4) Learning Objectives

After completing this course, a student will be able to:

o Explain briefly the early technical and artistic history of photography to better understand the "taking versus making”
approaches to photography as an artistic medium.

e Demonstrate a thorough understanding of manual camera controls and what they accomplish visually to create successful
images.

o Apply basic retouching workflow as it applies to Camera RAW and Photoshop to improve photographs.

o Set up simple studio lights to create specific lighting effects in photographs.

o Exhibit technical skills and address elements of design to create successful photographic compositions.

e Begin to discuss photographs for their formal, aesthetic, and conceptual qualities to develop information and visual literacy
skills.

About the Images in this Book

In addition to open and Creative Commons licensed images, several of the photographs featured in this book are the work of
students in Northern Illinois University's photography program. By including their work, this book embodies the principles of open
pedagogy, which invites students to participate in the teaching process and the co-creation of knowledge. Additionally, the
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collection will evolve over time, with new images from students being continually added. This ongoing inclusion not only keeps
the book fresh and relevant but also provides a platform for students to share their creative endeavors with a broader audience.
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Licensing

A detailed breakdown of this resource's licensing can be found in Back Matter/Detailed Licensing.
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Preface

The Creation of this Open Educational Resource (OER)

This textbook and ancillary materials were created as part of the Illinois Support for the Creation of Open Educational Resources
(SCOERs) project, facilitated by the Consortium of Academic and Research Libraries in Illinois (CARLI) and funded by a $2
million Open Textbooks Pilot Program grant from the Department of Education and the Fund for the Improvement of Post-
Secondary Education.[1]

Illinois SCOERSs is a true statewide enterprise fundamentally changing the open educational resources landscape in Illinois by
providing a new holistic support model that promotes student success through OER awareness, implementation, growth, and
adoption. This project features a collaboration between educational systems in Illinois, the library community, and workforce
representatives. Developed OER course materials will be released under a license that permits their free use, reuse, modification,
and sharing with others., the library community, and workforce representatives. Developed OER course materials will be released
under a license that permits their free use, reuse, modification, and sharing with others.

About this Book

This book and its ancillary materials were made possible through an Illinois SCOERs Subgrant awarded to Larissa Garcia and
Jessica Labatte at Northern Illinois University to create materials for undergraduate photography courses.

Contributors

The creation of this OER textbook was made possible through the collaborative efforts of educators, librarians, and staff from
Northern Illinois University. In particular, we gratefully acknowledge Amy Fleming, Emma Vitallo, Missy Clapp, and Cynthia
Paralejas for their time and expertise, which were instrumental in bringing this project to fruition.

lllinois SCOERSs Project Staff

The Illinois SCOERs Project Staff helped coordinate the management of the Open Textbook Pilot grant that made this OER
possible. Topical experts shared their knowledge on open educational resources, incorporating technologies including 3D printing,
accessibility, author rights, instructional design, publishing, and participated with the review and proofreading processes.

o Anne Craig, Principal Investigator, CARLI Senior Director

e Michele Leigh, Project Director, CARLI Senior Coordinator Open Illinois

e Margaret Chambers, CARLI Director and Advisor, Membership and Communications

e Michelle Haake, CARLI Senior Coordinator Membership and Communications

o Diane Day, CARLI Fiscal Officer

¢ Elizabeth Clarage, CARLI Director, Collections Services and OER Committee Liaison

o Nicole Swanson, CARLI Senior Coordinator, Library Services and Outreach and OER Committee Liaison

e Sara Benson, Copyright Training Coordinator, Assistant Professor, Copyright Librarian, University of Illinois Urbana-
Champaign

o Emily Boles, Instructional Design Coordinator and Trainer, eLearning Specialist, University of Illinois Springfield

o Elisandro (Alex) Cabada, 3D Printing Coordinator Trainer, Assistant Professor and Medical & Bioengineering Librarian,
University of Illinois Urbana-Champaign

e Ann Fredricksen, Disability Specialist, Coordinator of Accessible Media Services, University of Illinois Urbana-Champaign,
Disability Resources and Educational Services (DRES)

o Kathleen Ricker, Proofreader, ProofreadingPal.com Editing Services

Advisory Committee

The Illinois SCOERs Advisory Committee provided input on the subgrant applications, and the materials produced and contains
industry members, librarians, graduate students, and representatives from our project partners:

¢ Illinois Community College Board

o Illinois Board of Higher Education

o Tllinois Department of Commerce & Economic Opportunity
e Illinois Heartland Library System

e Reaching Across Illinois Library System

https://human.libretexts.org/@go/page/231987
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o Illinois State Library

o Illinois Library Association

o Health Sciences Librarians of Illinois

o University of Illinois Urbana-Champaign’s Division of Disability Resources and Educational Services

o Laurie Brown, Executive Director, Hickory Point Christian Village (assisted living) and Illinois Workforce Investment Board

Local 1949 Chair
o Lisa Jones, DCEO, Manager, Office of Employment & Training (state workforce agency)
e Suzanne Kinsey, Executive Director, Fox Valley Community Services, (in-home service agency) in DeKalb, LaSalle, Kendall,

and Kane Counties
¢ Danna Williamson, Nursing Education Specialist, Carle Foundation Hospital Clinical Education

Peer Review
The Peer Reviewer process was completed by the following reviewers:

e Marzena Abrahamik, Associate Professor/Adjunct, Photography, School of the Art Institute of Chicago

¢ Tim Arroyo, Assistant Professor, Photography, College of Dupage
e Abbey Hepner, Area Head of Photography and Digital Media, Southern Illinois University, Edwardsville

o Jin Lee, Professor, Photography, Illinois State University

Request to Those Using This Resource: Usage Survey

We would love to hear if you have integrated some, or all of this resource into your course. Please submit usage information every
semester for grant reporting purposes using this short survey. Your personal information will be kept private and only the usage
data will be shared with the Department of Education.

Customization/Terms of Use
This textbook is licensed under a Creative Commons Attribution 4.0 International (CC-BY) license unless otherwise indicated,
which means that you are free to:

e SHARE - copy and redistribute the material in any medium or format
e ADAPT - remix, transform, and build upon the material for any purpose

Licensing Terms

The licensor cannot revoke these freedoms as long as you follow the license terms.

o Attribution: You must give appropriate credit, provide a link to the license, and indicate if any changes were made. You may do
so in any reasonable manner, but not in any way that suggests the licensor endorses you or your use.
o No Additional Restrictions: You may not apply legal terms or technological measures that legally restrict others from doing

anything the license permits.
o Notice: You do not have to comply with the license for elements of the material in the public domain or where your use is

permitted by an applicable United States copyright exception or limitation.
o No Warranties are Given: The license may not give you all of the permissions necessary for your intended use. For example,

other rights such as publicity, privacy, or moral rights may limit how you use the material.

Attribution
Some of the content for this textbook was adapted from other open educational resources. For specific reference information about
what was used and/or changed in this adaptation, please refer to the references at the end of each section of the book.

Suggested Attribution Statement for this Book
Content that is not taken from the above OER should include the following attribution statement:

Labatte, Jessica and Larissa Garcia. (2024). Illinois SCOERs. Fundamentals of Photography and Creative Practice by
Consortium of Academic and Research Libraries in Tllinois licensed under CC BY 4.0.

References
This Preface chapter is a derivative of Ernstmeyer, K., & Christman, E. (Eds.). (2022). Nursing Mental Health and Community
Concepts by Chippewa Valley Technical College is licensed under CC BY 4.0
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[1] The contents of this publication were developed under a grant from the Fund for the Improvement of Postsecondary Education,
(FIPSE), U.S. Department of Education. However, those contents do not necessarily represent the policy of the Department of
Education, and you should not assume endorsement by the Federal Government.
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CHAPTER OVERVIEW

1: Creative Camera Functions

In this chapter, you will learn about early photography, how a camera works, basic camera settings, the definitions of common
photography terms and concepts, how to import image files from the camera to your computer, and how to make a contact sheet. To
ensure learning, you will go through a series of exercises to understand how these terms and settings translate into images.
Understanding the manual camera controls and what they accomplish visually is an important first step in developing photography
skills and the ability to discuss images thoughtfully.

1.1: A Brief History of Early Photography

1.2: How a Camera Works

1.3: Recommended Camera Settings

1.4: Form and Composition

1.5: Camera Function Exercises

1.6: Importing Images in Adobe Bridge

1.7: Making Contact Sheets in Adobe Bridge

1.8: Learning Checkpoint

1.9: Creative Camera Functions and Digital Contact Sheets Assignment

This page titled 1: Creative Camera Functions is shared under a CC BY 4.0 license and was authored, remixed, and/or curated by Jessica Labatte

and Larissa Garcia (Consortium of Academic and Research Libraries in Illinois (CARLI)) .
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1.1: A Brief History of Early Photography

The early technical and artistic history of photography is characterized by a reciprocal relationship between technological
innovations and the social, cultural, and artistic uses of the medium. Although the theories underlying the camera were known in
antiquity, the chemical processes involved in creating images were not known until the nineteenth century.

The Camera Obscura and Early Photographs

A camera obscura (“dark chamber” in Latin) is a device that contains a small hole for light to pass through and projects an
inverted image of an external object. Although it dates to ancient Greece and the Chinese Han Dynasty (c. 468-391 BC), Idn al-
Haytam (965-1050) was a medieval scientist and mathematician known as the earliest user of the camera obscura. Leonardo da
Vinci (1452-1519),! who was familiar with al-Haytam's work, even described it in his Codex Atlanticus (1502).> Renaissance
artists in the sixteenth century used camera obscuras to project an inverted image of a subject onto paper that could be traced to
produce a highly accurate representation. Camera obscuras were used until French inventor Joseph Nicéphore Niépce (1765-1833)
developed heliography, the process of photoengraving an image on a light-sensitive surface. This technological advancement marks
the birth of photography.

Figure 1.1.1: Joseph Nicéphore Niépce, View from the Window at Gras (1826) (Public Domain)

Image Description: A grainy photograph showing a somewhat vague view of buildings and rooftops.

After this point, innovation in the field of photography developed in three areas: speed or exposure time, resolution or the clarity of
an image, and permanence. Early photographs, such as Niépce’s famous View from the Window at Gras (1826), were created only
through excruciatingly long exposure periods, i.e., a very slow shutter speed. View from the Window boasts a shutter speed of
approximately eight hours. This gradual transference of images meant the artists were limited in their subject matter. To capture
View from the Window, Niépce set up a camera obscura to expose a silver and pewter-coated copper plate across the day. It is blurry
and the resolution, or clarity, is grainy due to natural changes in conditions outside his window during that long exposure time.
Niépce’s work also suffered from the lack of permanence of the images he captured. His medium would continue to react to light as
time passed, eventually turning black. He did not solve this problem in his lifetime but, in 1839, the chemical hyposulfite of soda,
nicknamed hypo, was invented, which allowed images to be more permanently fixed to paper.
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Figure 1.1.2: Louis-Jacques-Mandé Daguerre, The Artist’s Studio / Still Life with Plaster Casts (1837) (Public Domain)

Image Description: A black and white photograph of objects on a table including two plaster angel heads below a coat, large
flask, and framed picture hanging from the wall.

Photographers after Niépce experimented with a variety of techniques. Louis Daguerre invented a new process that, after
experimenting for several years, he presented to the French Académie des Sciences in 1839. His discovery, which he named
daguerreotype, significantly reduced exposure time and created a lasting image. The daguerreotype process did not allow for
prints to be made of the image, however.

2

Figure 1.1.3: William Henry Fox Talbot, The Open Door, 1844, salted paper print from paper negative (Public Domain)

- Ko i

Image Description: A salted print photograph with gold tones depicting an open barn door with a broom leaning diagonally
to the left of the door frame.

At the same time, Englishman William Henry Fox Talbot was experimenting with what would eventually become his calotype
method, patented in February 1841. Talbot’s innovations included the creation of a paper negative and new technology that
involved the transformation of the negative to a positive image, allowing for more than one copy of the picture. The remarkable
detail of Talbot’s method can be seen in his famous photograph, The Open Door (1844), which captures the view through a humble
stable door. The texture of the rough stone structure, the vines, the rustic broom, and the bridle hanging from the hobnailed door
demonstrate the minute details captured by Talbot’s photographic improvements.
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The collodion method was introduced in 1851. This process involved fixing a substance known as gun cotton onto a glass plate,
allowing for an even shorter exposure time of three to five minutes and producing a clearer image.

The main disadvantage of the collodion process was that it needed to be exposed and developed while the chemical coating was
still wet, which meant that photographers had to carry portable darkrooms to develop images immediately after exposure. Nadar,
born Gaspard-Félix Tournacho, one of the most prominent photographers in Paris at the time, was known for capturing the first
aerial photographs from the basket of a hot air balloon using the collodion method. Both the difficulties of the method and
uncertain but growing status of photography were lampooned by Nadar’s friend Honoré Daumier in the lithograph Nadar Elevating
Photography to the Height of Art (1862).
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Figure 1.1.4: Eadweard Muybridge, The Horse in Motion (Sallie Gardner was owned by Leland Stanford; running at a 1:40 pace
over the Palo Alto track, June 19, 1878) (Public Domain)

L

Image Description: A series of black and white silhouettes of a horse and rider in various stages of motion in a table of four
columns and three rows.

Further advances in technology continued to make photography less labor-intensive. By 1867 a dry glass plate was invented,
reducing the inconvenience of the wet collodion method.

Artists could purchase prepared glass plates, eliminating the need to mix chemicals. In 1878, new advances decreased the exposure
time to 1/25th of a second, allowing moving objects to be photographed and lessening the need for a tripod. This new development
is celebrated in Eadweard Muybridge’s sequence of photographs called The Horse in Motion (1878). Designed to settle the debate
of whether all four legs of a galloping horse ever come off the ground at the same time, the series of photographs also demonstrated
the new photographic methods that were capable of nearly instantaneous exposure.

In 1888 George Eastman developed dry gelatin roll film, making it easier for film to be carried. Eastman also produced the first
small, inexpensive cameras, allowing more people access to the technology.

Photographers in the nineteenth century were pioneers in a new artistic endeavor. Frequently using traditional methods of
composition married with innovative techniques, photographers created a new vision of the material world. Despite the struggles
early photographers faced with the limitations of their technology, their artistry is obvious.
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1.2: How a Camera Works

Cameras work by capturing light reflected off a scene or image and recording it on a medium. For analog cameras, the medium is
film. For digital cameras, the medium is an image sensor. On digital single-lens reflex (DSLR) cameras, aperture settings control
the amount of light that enters the camera and a shutter controls how long the light is allowed to enter the camera.

DSLR Digital Camera

LIGHT
PATH

1. Viewfinder (eyepiece lens)  ¥. Electronics

2. Penlaprism 10. Autofocus system

3. Focusing screen 11. Reflex and relay miror

4. Condenser lens 12, Focusing elements

5. Color and infrared filter 13, Aperture

6. Digital sensor 14, Zoom elements

7. Shufter 15, Front line gothering elements

8. Display 16. Batteries

Figure 1.2.5: DSLR Digital Camera Parts (CC BY; Guru Camera via flickr)

Image Description: A side view diagram of a DSLR digital camera held up to a person's eye, showing the various
components and their positions inside the camera body. It includes labels for the viewfinder, pentaprism, autofocus system,
digital sensor, shutter, display, and other elements and shows the light path through the camera to the eye.

The lens of the camera collects light from an object and focuses it through to the recording medium. The aperture, also known as
“f-stop,” is the opening in the camera lens that allows light to be recorded on the image sensor. The aperture also controls depth of
field, or the distance of focus or sharpness between the closest and farthest objects in a photograph. It is also the aperture that
controls the intensity or amount of light that reaches the image sensor. A wide aperture (low f-stop) lets in more light, and a narrow
aperture (high f-stop) restricts it.

Each lens has a focal length that describes its optical capabilities. The lens determines the angle of view (how much of the scene
will be captured) and the magnification (how large individual elements will be). Focal length is represented in millimeters (mm)
and is usually printed on the lens.

Focus refers to how sharp an image is. To sharpen the image, the camera lens allows for manual focus and autofocus. A
photographer uses manual focus when they want control over what part of the image is in focus. Autofocus is when the camera
sharpens the image automatically. However, even when using autofocus, the photographer can guide the focus of the image by
pressing the shutter halfway down, which snaps the focus to the subject in the frame. Digital cameras generally focus very well, so
as you are learning, it is a good idea to use autofocus. However, experiment with both techniques and use the one that better
ensures your subject is properly focused.

The shutter is the mechanism that controls the length of time that the image sensor is exposed to light. Shutter speed is the time
measured in fractions of a second that the shutter is opened, which determines the length of time the light hits the image sensor. A
slow shutter speed (longer than 1/60th of a second) blurs motion. A fast shutter speed (shorter than 1/60th of a second) freezes
motion.

ISO (International Standard Organization) refers to the numerical rating that describes the image sensor’s sensitivity to light, or
how sensitive the camera is to the amount of light in the scene being photographed. The ISO determines how much light is needed
for correct exposure. A low ISO (100 or lower) is less sensitive and requires more light or longer exposure times to have a correctly
exposed image. A high ISO (400 or higher) is more sensitive and requires less light or a shorter exposure time to take a picture.

ISO is the first setting to adjust on your camera and should be set based on the amount of light available in a scene. For example, if
you are working indoors where light is limited, you would adjust your camera to a high ISO. If you are photographing subjects
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outdoors on a sunny day, you would use a low ISO.

The ISO also affects image quality because it determines the amount of noise or grain (digital artifacts) within an image. For
example, although you can take a picture without a flash in low light by using a high ISO setting and a faster shutter speed, noise
will occur on the photo because a higher ISO causes more noise or grain than a lower setting. Therefore, ISO determines what
combination of shutter speed and aperture settings should be used to produce a correctly exposed image. The lower the ISO
number, the higher the image quality (free from grain or noise), but the more light is required to take the picture. ISO 100400 is
recommended for best image quality, especially if the intention is to print the image. Using an ISO above 400 can result in a grainy
or noisy image, which will be visible in the final print.

ISO 800

Figure 1.2.6: ISO Differences (CC BY-SA; MikeRun via Wikimedia Commons)

Image Description: A series of the same color photograph of a yellow rose at different ISO settings. ISO 50 is darker; ISO
200 has a medium exposure; ISO 800 shows the rose as very bright.

Exposure is the relationship between ISO, shutter speed, and aperture that produces the right balance of tones (or correct exposure)
in an image. For any scene, there is a correct exposure determined by the amount of light available and the specific camera
settings the photographer chooses. However, correct exposure is relative; you can adjust shutter speed, aperture, and ISO to capture
the image you envision. When photographing with a DSLR camera, you most often use the reflected light meter readings inside
the camera to determine exposure.
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Figure 1.2.7: Exposure Triangle of Aperture, Shutter Speed, and ISO (CC BY-SA; WClarke and Samsara via Wikimedia

Commons)

Image Description: An image of the exposure triangle showing the relationship between shutter speed, aperture, and ISO.
Shutter speed is depicted on the left side of the triangle: the slower the shutter speed, the motion becomes blurry; the faster
the shutter speed, the motion freezes. Aperture is depicted on the right side of the triangle: the wider the aperture, the
shallower the depth of field; the narrower the aperture, the greater the depth of field. ISO is depicted on the bottom side of
the triangle: the lower the ISO setting, the less noise in the photograph; the higher the ISO setting, the more noise in the
photograph.

When the camera is pointed at a scene, the light meter will predict a correct exposure based on the camera’s ISO setting, aperture,
and shutter speed. A correct exposure is determined by the light meter averaging out the lights and darks in the scene to create
middle grey, or 18% grey. These settings are relational and interdependent; when you change one setting, your overall exposure
changes.

For any scene, there is one correct exposure, but several setting combinations to get there.

In different conditions the temperature of light, or perceived color, varies. Therefore, white balance is the camera function that
matches the temperature of light in a scene with the color recorded on the image sensor. Correct white balance produces a more
accurate representation of color within an image. A grey card helps get a correct reflected exposure meter reading and can be used
to set the white balance for a scene. Using a grey card gives you more control over the exposure and white balance settings to
ensure a more accurate rendering of colors.

X How to Use a Grey Card

1. Put the grey card in the area where you plan to photograph the subject.
2. If using artificial light, make sure you light the grey card the same way you plan to light the subject.

3. Find and select the “custom white balance” option in your camera. Note that some cameras make you take the picture and
then select “custom white balance.”

4. Fill the frame with the grey card.
5. Note that it helps to do this process more than once to ensure the light is being registered correctly.

6. Or take a picture with the correct exposure and see if the shift in white balance applied.

Each camera has a set megapixel or MP (1 million pixels = 1 megapixel), which is the camera’s resolution. Resolution is the level
of detail in an image and is measured using pixels. Pixel dimensions are the number of pixels along an image’s width and height.
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To find out how many megapixels are in an image, view the image size in Photoshop and multiply the width times the height. The
higher the resolution and more megapixels the camera has, the higher quality image the camera can produce. Many DSLR cameras
have a resolution of 12-25 MP. When purchasing a camera, it is important to keep the relationship of MP and image quality in
mind.

It is also important to have at least one memory card for your digital camera. Memory cards are small, removable hard drives that
provide additional storage for the camera, and it is where the image file for each picture taken is saved. Memory cards come in
various types (i.e., SD, miniSD, or CF), and they have different amounts of storage space. Their size is usually measured in GB, so
a larger GB card will allow for more saved images before deleting to make space. Memory cards also have a speed associated with
them. A higher speed card allows the camera to process and save images more quickly.

Before taking pictures, format the memory card to your camera’s operating system. It is also recommended that you reformat the
SD card to delete the image files instead of using the trash can feature in the camera or on the computer. This way you delete the
image files while preventing the card from getting corrupted. However, some photographers never reformat or delete images from
their memory cards and choose instead to buy a new one each time the card is full.

This page titled 1.2: How a Camera Works is shared under a CC BY 4.0 license and was authored, remixed, and/or curated by Jessica Labatte and
Larissa Garcia (Consortium of Academic and Research Libraries in Illinois (CARLI)) .
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1.3: Recommended Camera Settings

The DSLR camera manual settings allow for creative control, so you can decide which aperture, shutter speed, ISO, and various
other settings are used when creating photographs.
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Figure 1.3.8: DSLR Digita Camera (CC BY; Guru Camera via flickr)

Image Description: An image of a Canon digital camera with the various external components labeled, including the power
switch, shutter button, mode dial, built-in flash/AF-assist beam, lens mount index, and more.

The settings below can be accessed via your camera’s menus.

o Image Quality refers to the resolution of the image. Choose the RAW file format. This is the unprocessed image data from the
camera’s image sensor and results in the highest quality image.

o Color Space is the range of colors shown in a photo. Cameras have different options for this setting. Select Adobe RGB 1998
in your camera for image capture to create images with the best range of color and to ensure consistency when printing.

¢ White Balance determines the camera’s relationship to the color temperature of the light you are working in. Choose from
three options:

o Presets for color temperature of lights = tungsten, fluorescent, etc. This is a good setting if you understand lights and their
relationship to color temperature.

o Custom White Balance = most accurate setting. Use when possible.

o Auto White Balance = good for general purpose. Second best choice.

e Metering Mode determines how the light meter inside the camera measures exposure and the amount of light available in the
scene. DSLR cameras measure reflected light, the light that bounces off a subject and is reflected into the camera.

o Select the matrix or evaluative setting, which is the most balanced overall option for in-camera reflective light reading.
o You can also use a hand-held light meter, which measures reflected light and incident light, which is the light falling on a
subject. Measuring incident light is a slightly more accurate way to correct exposure for a photograph.

e ISO determines how sensitive the camera is to the amount of light in the scene being photographed. The lower the ISO number,
the higher the image quality (free from grain or noise), but the more light is required to take a picture. A higher number requires
less light to take a picture but can result in a grainy or noisy image with lots of digital artifacts.

o ISO 100-400 is recommended for best image quality. If using an ISO above 400, your image will be full of digital artifacts.

o Aperture determines the intensity of light let into the camera through the lens and controls the depth of field.

o F/2.8 = a wide-open aperture, lets in a lot of light, and has a shallow depth of field.
o F/8 = a medium opening or the mid-point, not too much or too little light, and has a medium depth of field.
o F/22 = a small opening, lets in very little light, and has a wide depth of field across the image (preferred).

o Shutter Speed controls how long light is let into the camera through the lens and is measured in fractions of a second. Set this
speed according to the exposure meter reading. Use the camera timer or remote to reduce camera shake for longer shutter
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speeds.

o 1/5 = one fifth of a second, a slow/long shutter speed; the motion will blur.
o 1/60 = shutter speed that freezes motion.

o 4,000 = one 4,000th of a second, very fast/short shutter speed; the motion will be frozen.
o Exposure is the relationship between ISO, shutter speed, and aperture. Therefore, achieving the correct exposure will depend
on the ISO, shutter speed, and aperture settings you choose according to the visual effects desired.

Lens Focal Length describes a photographic lens, represented in millimeters. It describes where the light rays entering the lens
converge before striking the image sensor.

o 18-35 mm are common wide-angle lenses that capture a broader view of a scene. Wide-angle lenses can produce image
distortions such as bowing of the horizon or the sides of buildings.

o 50 mm is standard for DSLR cameras and results in the least amount of image distortion.

80-300 mm are common telephoto lenses that allow you to magnify a subject that is far away. These lenses compress the
space of a photograph, making objects appear closer.

o Zoom lenses provide the most flexibility because you can change the focal length.

o Fixed lenses have one focal length that cannot be changed, but they produce a sharper image.

This page titled 1.3: Recommended Camera Settings is shared under a CC BY 4.0 license and was authored, remixed, and/or curated by Jessica
Labatte and Larissa Garcia (Consortium of Academic and Research Libraries in Illinois (CARLI)) .
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1.4: Form and Composition

It is a good idea to keep form and composition in mind when getting ready to take a photograph of your subject. As you approach
your subject with your camera and frame the image in the viewfinder, consider the form and composition of your subject to create
the most visually interesting photographs. Form (elements of design) refers to the physical parts or visual components of a
work, including line, shape, mass/volume, perspective, texture, and color. Composition (principles of design) refers to the ways the
design elements are arranged to produce a specific effect. When taking a photograph, the camera becomes an extension of your eye.
You use the camera frame to compose the image, choosing the design elements to include and exclude in the frame. When framing
your subject, consider the design elements in your view finder that can help to create the most dynamic composition.

One way to approach composition is to consider how the subject occupies the foreground, middle ground, and background of the
image. Composing a picture with attention to these layers of composition and their relationship to each other can add visual interest
to the image. To understand foreground, middle ground, and background, horizontally divide your photograph into three sections.

Figure 1.4.1: Stretches of Land. (CC BY-SA 2.0; rcadby14 via flickr)

Image Description: Photograph of a wide desert landscape with a dry, brownish-gray floor scattered with low shrubs and
grasses. Near the bottom center foreground, a cluster of small yellow flowers on slender stems stands out against. In the
middle ground, there are saguaro cacti and rocks. The background features a distant mountain range against a clear blue sky.

The foreground is the bottom layer, which appears closest to the photographer. In the image above, the foreground contains the
yellow flowers in the bottom left corner.

The middle ground is the layer of the image that sits on top of the foreground and appears to be farther away from the
photographer. The middle ground of this image includes the saguaro cacti.

The background is the top layer of the image, above the middle ground, which appears farthest away from the photographer. In this
image, the background is the mountains and sky. The background offers important context to the image and can be in focus or
blurred depending of the choice of aperture.

Two other important compositional methods for photographers are the rule of thirds and the golden ratio. The rule of thirds refers
to the placement of the subject at the intersection of the imaginary horizontal and vertical lines that divide the image into three
parts. The rule of thirds can be visually constructed through the placement of subjects across the foreground, middle ground, and
background of an image as seen in the image below.
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irds. (CC BY-NC-SA; Marie Coleman via flickr)
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Figure 1.4.9: A natural example of the rule of th

Image Description: Close-up color photograph of a yellow sunflower with green leaves in front of a wire fence. The fence
divides the image into a grid with the sunflower in the line dividing the right third of the image.

The golden ratio is the relationship of parts achieved when the longer part divided by the smaller part is also equal to the whole
length divided by the longer part. It is thought to provide the most harmonious and visually pleasing proportions in art and
architecture.

Figure 1.4.10: The golden rectangle whose side lengths are in the golden ration. (CC BY; The Marmot via flickr)
Image Description: Black and white photograph that highlights the spiral shape of the nautilus shell by adding a golden
rectangle overlay.
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1.5: Camera Function Exercises

These exercises provide the opportunity to learn the important functions of a DSLR camera in manual mode. You will experiment
with aperture, shutter speed, ISO, explore the importance of white balance and, upon completion, you should be comfortable with

creating proper exposure for these manual settings.

? Time of Day Exercisel.5.

How does the time of day affect your pictures? Does the same subject look different at different times of day?

Figure 1.5.1: Shistine Peterson (NIU/BFA student). Farmstead. (CC BY; Shistine Peterson)
Image Description: A dying potted palm plant sits in the middle of an empty room with late afternoon sunlight coming
through the windows.
1. Choose one landscape to photograph.
2. Photograph the same landscape at various times of day.

3. Choose two pictures that show the most interesting contrast of times of day.

? Bracketing Exercise 1.5.

Bracketing: The intentional overexposure and underexposure of an image by a photographer to capture a wider range of
information for the image. This technique can capture details in highlights or shadows that might be otherwise lost and can be
especially helpful during the editing process when you have a scene with a great variance of tones, such as backlit subjects,

sunsets, night scenes, or landscapes with dramatic clouds.
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Figure 1.5.1: Bracketing: Overexposed, correct exposure, underexposed. (CC BY-NC-ND; Emma Vitallo, NIU/MFA student)

Image Description: Three images side by side of a floor to ceiling window corner inside a building, exactly the same.
The left image is overexposed; the center image is correctly exposed; and the right image is underexposed.

To bracket, set your camera on a tripod so that you can frame the exact same picture multiple times with various exposures.
The composition should remain the same; change only the exposure. Change either the aperture or the shutter speed, but do not
change both simultaneously. When deciding which setting to change, consider the visual qualities of your image and the visual
qualities associated with aperture and shutter speed.

This technique is also used to make high-dynamic range (HDR) photographs.

Choose either aperture or shutter speed to focus on by considering the visual qualities of your image and the visual qualities
associated with these settings. Tip: the most common form of bracketing is to take one photograph with the correct
exposure, and then take one photograph one stop (one exposure setting, either aperture or shutter speed) overexposed and
another photograph one stop underexposed. You might even want to try taking two stop increments.

Instructions

o Photograph a backlit subject such as a person sitting next to a window or standing in front of a sunset. Try to bracket so the
sunset or window is correctly exposed. Then, bracket so the person is correctly exposed.

o Photograph an interior scene with a window in the frame. Try to bracket so you have the objects inside the interior correctly
exposed and the object outside the window correctly exposed.

o What other scenarios would be good for bracketing?

? Shutter Speed Exercise 1.5.

Shutter Speed and Motion: Shutter speed is the time measured in fractions of a second that the shutter is opened, which
determines the length of time the light hits the image sensor. A slow shutter speed (longer than 1/60th of a second) blurs
motion. A fast shutter speed (shorter than 1/60th of a second) freezes motion.

A slow shutter speed (anything slower than 1/60th of a second) blurs motion.

A fast shutter speed (anything faster than 1/60th of a second) freezes motion.
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Figure 1.5.1: Shistine Peterson. Tea Kettle. (NIU/BFA student. (CC BY; Shistine Peterson)

Image Description: In-focus image of cream and brown tea kettle on a gas stove with steam coming from it while the
background is not in focus.

Instructions

e Choose a moving subject.
e Blur: Use a shutter speed slower than 1/60 to create blurred motion.
o Freeze Motion: Use a fast shutter speed to freeze motion.

? Aperture Exercise 1.5.

Aperture: The opening that lets light through the lens to the image sensor and controls depth of field. It is also known as “f-
stop.”

Instructions

e Set up one scene using multiple objects. Place the objects at different distances within the composition. Photograph the
scene using each of the aperture settings on your camera, from /1.8 to f/22. Notice how each image has a different depth of
field.

o Take a photograph with a shallow depth of field. The subject in the foreground is in focus but the background should be
blurred and out of focus. Try a low number such as £/2.8.

o Use the same aperture as above. This time take a photograph where the object in the foreground is out of focus, leaving the
objects in the background in focus.

e Make an image with a great depth of field. Be confident that everything in the frame is in focus. Try using a high number
such as £/22.

? Focal Length Exercise 1.5.

Focal Length: Focal length is the distance from the subject to the lens plus the distance from the lens to the camera sensor.
The focal length describes the optical capabilities of a photographic lens. It is represented in millimeters and is usually printed
on the lens. Importantly, focal length will determine angle of view, which is how much of the scene will be captured. The
longer the focal length, the narrower the angle of view and the higher the magnification. The shorter the focal length, the wider
the angle of view and the lower the magnification.
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Figure 1.5.1: Aliya Noor (NIU/BFA student). Light and Shadow, 2023. (CC BY-NC-ND; Aliya Noor)

Image Description: Close up of large plant leaves that look yellow because of the sunlight shining behind them creating
different light and shadows.

Common DSLR Lens Focal Lengths

o Fisheye lens: 7mm—16mm

o Very wide angle that produces a circular image with bent and distorted edges.
o Useful for capturing wide landscape views, such as cityscapes or a horizon line if you want the images to appear
rounded
o Wide-angle lens: 10mm—-42mm

o Allows you to capture an expansive view of a scene or landscape, or to take a large group photo.
o Can result in image distortions, i.e., bowing of the horizon or the sides of buildings.

o Standard lens: fixed focal lengths of 50mm, 85mm, and 100mm

o Useful for portraits or still life photography and for live event photography with moving subjects.
o 50mm is standard for DSLRs and will result in the least amount of distortion for images.

o Telephoto lens: 100mm—-800mm
o Can capture subjects from hundreds of feet away.
o Has a narrow field of view and a shallow depth of field.
o These lenses compress the space of a photograph, making objects appear closer to each other than they actually are.

Instructions
Zoom In

1. Set your lens to the widest-angle focal length available.

2. Frame your subject and take a picture.

3. Next, zoom in to the next focal length listed on your camera lens.

4. Frame the same subject the same way and take a picture.

5. Continue until you have taken a picture of the subject at all the available focal lengths.

Zoom Out

1. Set your lens to the longest focal length available.

2. Frame the subject and take a picture.

3. Next, zoom out to the next focal length listed on your camera lens.

4. Frame the same subject the same way and take a picture.

5. Continue until you have taken a picture of the subject at each available focal length.

Get Closer
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1. Choose a subject at least 10 feet away for a photograph.

2. Compose the image and take a picture.

3. Next, take one large step closer, recompose, and take a picture. Do not use the zoom lens; physically move your body
closer to the subject.

4. Continue the process until your lens will no longer focus on the subject because you are too close.

Give Me Some Space

1. Choose a subject for a photograph.

2. Compose the image and take a picture.

3. Next, take one large step back, recompose, and take a picture. Do not use the zoom lens; again, physically move your
body farther away from the subject.

4. Continue the process until you can no longer move farther away.

? Vantage Point Exercise 1.5.

Vantage Point: The place from where you take a photograph, or the photographer’s perspective. The vantage point is an
integral part of taking a photograph and can affect the angles, composition, and narrative of the image. Although we think of
photographs as being an accurate depiction of the world, changing the vantage point can change not only our perception of the
world, but also the meaning intended.

Instructions
New Perspective
Take a photograph where the new perspective is an integral part of the picture. For example:

1. Kneel. Or stand tiptoed. Take a picture from a new high or low angle.
2. Stand still in a place through which you normally move quickly and take a photograph.

Same Photograph, Different Perspective

1. Photograph the same object from multiple perspectives.
2. Notice how the background shifts as you move around the subject.
3. How can a new perspective change the meaning of your picture?

Bird’s-Eye View
1. Take a picture of something from a bird’s-eye view.
2. How does this unusual vantage point change your understanding of the image?
Shift the Scale
1. Use depth of field and vantage point to shift the size and scale relationship of two objects.

2. Use an aperture with a deep depth of field of {/16 or higher.
3. Frame your subjects and create a composition where size relationships are distorted through the vantage point.

World’s Largest [insert any common, everyday object]

1. Get low.

2. Use a worm’s-eye view to create an exaggerated sense of size and scale.

3. Your picture should make this common, everyday object seem grand, huge, even momentous in importance
compared to the surrounding landscape.

This page titled 1.5: Camera Function Exercises is shared under a CC BY 4.0 license and was authored, remixed, and/or curated by Jessica
Labatte and Larissa Garcia (Consortium of Academic and Research Libraries in Illinois (CARLI)) .
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1.6: Importing Images in Adobe Bridge

Once you have taken photos with your camera, you will need to transfer them from the camera to your computer. There are many
digital asset management programs that allows you to import, organize, and edit images. Adobe Bridge is a free program that is
used in NIU photography courses. With Adobe Bridge, you can convert the RAW image files from your camera to DNG (digital
negative files) while they are copying to your hard drive. Note: all digital cameras save image files in their own RAW format (i.e.,
Nikon uses their own .NEF file suffix, Canon uses .CR2, and Sony uses .SNY). However, it is best practice to convert these RAW
files to .DNG, the more universally used file format supported by Adobe.

X A Note about File Organization

It is important to be consistent in the organization of your digital files to ensure they can be easily found and accessed. It is best
practice to create folders according to the following structure:

NIU > SemesterYear > Class > Assignment

For example: NIU > Fall2023 > ARTD 313 > Creative Camera Functions

Within the assignment folder, create folders for each type of file format:

e RAW/DNG

o Retouched: Images that have been edited in Camera Raw or Photoshop
e Print: Ready-to-print files

e JPEG: For smaller, resized JPEGs to share online or by email

Using an app like Adobe Bridge is preferable to importing directly into photo editing programs because you have more control over
the image files. For example, Microsoft Photos converts raw files to smaller JPEG when importing images, which reduces image
quality. Because photographers prefer to make decisions about how images are modified, it is best to avoid editing programs that
make automatic adjustments.

1. Open Adobe Bridge.

2. Connect the camera or memory card to the computer. You can use a memory card reader, the camera cord, or the card reader
built into your computer.

3. If Bridge Photo Downloader does not automatically open, select the camera icon from the top menu bar in Bridge. When you
hover the mouse over this icon, it will say Get Photos from Camera.

4. In the Photo Downloader menu, go to Get Photos From and select your memory card or camera. If your memory card/camera
does not show automatically, select Refresh List from the drop-down menu.

5. Once your device has been selected, the thumbnails of all the images on your memory card/camera will appear. Select the
images you wish to import by checking the box beneath the thumbnail.

6. Once you have selected the images to import, go to Save Options on the right side of the window.

o Location: Choose the location to save your files.

¢ Create Subfolder(s): Choose a name for the assignment folder.

e Rename Files: Assign a custom name to your files as they are imported (i.e. Lastname_projecttitle). Select the subfolder.
You can choose to add the date to the custom name.

e Itis a good idea to use the assignment title in the file name. Then, choose the number you would like the automatic
numbering system to start with.

e Check the box for Preserve Current File name in XMP.

7. Under the Advanced Options, check Open Adobe Bridge. This will show you the files in Bridge once they have been imported.
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Figure 1.6.1: Adobe Bridge Photo Downloader. (CC BY-NC-ND; Emma Vitallo, NIU/MFA student)

Image Description: A screenshot of Adobe Bridge Photo Downloader with the checked box next to Open Adobe Bridge.

8. Check Convert to DNG. This converts your .NEF or .CR2 files into .DNG.
9. Click on the Settings button.

e JPEG Preview: Select Medium Size.

e Compression: Check Compressed (lossless).

o Image Conversion Method: Select Preserve Raw Image.
o Original Raw File: Check Embed Original Raw File.

o Then click OK.

10. Once Bridge has finished importing and converting your images, you can make editing selections and begin the retouching
process.

This page titled 1.6: Importing Images in Adobe Bridge is shared under a CC BY 4.0 license and was authored, remixed, and/or curated by Jessica
Labatte and Larissa Garcia (Consortium of Academic and Research Libraries in Illinois (CARLI)) .
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1.7: Making Contact Sheets in Adobe Bridge

With your images in Bridge, you can now make a contact sheet, a document that shows all the images captured for a particular
project. Contact sheets show your photographic process: how many pictures were taken, how you approached the subject, and the
images you did not select for printing. They allow your instructor to learn more about your work as a photographer.

_ENHZ9.0PG _END130.JPG _EIND131.0PG

_ENDA32 PG ENDI33IPG END134.0PG

Iﬁ 1

END136.4PG _END3TUPG _END138.UPG
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_EIND144.JPG _EVD145.0PG _EIVD146.JPG _EVD147.0PG

Figure 1.7.11: Contact Sheet Example (CC BY-NC-ND; Emma Vitallo, NIU/MFA student)

Image Description: Contact sheet of images, arranged four across and five down.

1. Open Adobe Bridge and navigate to the folder that contains the images for the assignment.

2. Select all images in the folder (Command + A). Selected images will be highlighted with blue squares. On the right side, you
will see the number of images selected.

3. In the menu bar, go to Tools > Photoshop > Contact Sheet II.

4. Photoshop will open a Contact Sheet II menu box. Select the following settings:

e Source Images

o

Use: Bridge, with the number of photo files selected.

e Document

o O O

[e]

o

o

o

Units: inches

Width: 8.5

Height: 11

Resolution: 300 pixels/inch
Color Profile: Adobe RGB 1998
Flatten All Layers: checked
Mode: RGB Color

Bit Depth: 8-bit

e Thumbnails

o

o

o

Place: across first
Columns: 5
Rows: 6
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o Rotate for Best Fit: checked
o Use Auto-Spacing: checked
o Use Filename as Caption

o Checked. This allows your file name to be selected underneath the image thumbnail.
o Font: Lucida Grande is the default; regular, 8 pt.

5. Then click OK. This will start the Photoshop automated process. It will open, resize, and place your images in the document.
When an 8.5 x 11-inch document has 30 images, a new document will be opened until all the images are placed.

6. When all of your contact sheets have been created, save the files to your assignment folder. In the menu bar, go to File > Save
As.

7. Then, in the Save As menu box, rename the file adding your last name: Smith_ContactSheet_AssignmentName.

o Select the folder you created for the class.
o Select the folder for the assignment.

e Format: JPEG

e Click Save.

8. Saving the file as a JPEG will prompt a menu for JPEG options. Choose Quality 8 and then click OK.

9. Upload this file to the appropriate OneDrive folder when you turn in your assignment.

This page titled 1.7: Making Contact Sheets in Adobe Bridge is shared under a CC BY 4.0 license and was authored, remixed, and/or curated by
Jessica Labatte and Larissa Garcia (Consortium of Academic and Research Libraries in Illinois (CARLI)) .
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1.8: Learning Checkpoint

Take a moment to review what you have learned so far and check your understanding with the questions below.

Figure 1.8.1: Jayla Watkins (NIU/BFA student). Time Capsule. (CC BY-ND; Jayla Watkins)

Image Description: A seated elderly woman, shown from the chest down, is dressed in cream-colored pants and top. Next to
her on the floor is a gold lidded ice bucket, a chessboard, and a wooden stereo. The room is brightly lit with white walls and
floor.

? Question 1.8.1

Which of the following is not necessary to capture an image with a camera?
a. Light

b. Lens

c. Aperture

d. Film

Answer

d. Film

? Question 1.8.2

What is focal length? Choose all that apply.

a. The distance from your subject to your camera, divided by the distance to the sun.
b. How much light hits your sensor.
c. Determines the magnification of a subject.

d. How much of the scene your lens can see.

Answer
a. The distance from your subject to your camera, divided by the distance to the sun.
c. Determines the magnification of a subject.

d. How much of the scene your lens can see.
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Which of the following does NOT affect the exposure?
a. Aperture

b. Autofocus

c. Shutter Speed

d. Time of Day

e. ISO

Answer

b. Autofocus

? Question 1.8.4

Which aperture setting should be used to let in very little light for a wide depth of field?
a.F/2.8

b. F/8

c. F/22

Answer

c. F/22

? Question 1.8.5

What file format should you convert your image files to when importing them from your camera to Adobe Bridge?
a. JPEG
b. DNG
c. TIFF
d. DOC

Answer

b. DNG

? Question 1.8.6

Why would your instructor want to see your contact sheets for a specific exercise or assignment?
a. They show how many images were created.

b. They show the images that were not selected.

c. They show your photographic process.

d. All of the above.

Answer

d. All of the above.
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1.9: Creative Camera Functions and Digital Contact Sheets Assignment

Purpose and Description

This assignment asks you to put together what you have learned in this chapter and submit images and contact sheets from the
camera functions exercises according to conventions used in this class.

Requirements

Submit 8 DNG image files and all contact sheets for the camera functions exercises in a labelled folder
(LastName_CreativeCameraFunctions) to the class OneDrive folder.

Image files should include:

o 2 images with depth of field that extends through the entire image

o 2 images with shallow depth of field

e 2 images with blurred motion

o 2 images with frozen motion

¢ Do not edit the images.

o All images should be captured in RAW format but converted into DNG.

o For the images that show depth of field, the subject of the photograph must be in focus.
e FEach image must be properly exposed.

¢ FEach image must have the correct white balance.

o All images should be captured with an ISO between 100—400.

o Images should have successful compositions that address elements of design.

Contact sheets should:

e Be 8.5in x 11in; 5 images across, 6 rows down
¢ Include file names

Each file (images and contact sheets) should be labeled following the following convention:

o LastName_entireDOF_1.dng
o LastName_shallowDOF_1.dng
e LastName_Frozen_1.dng

e LastName_Blur_1.dng

o LastName_ContactSheet.dng

This page titled 1.9: Creative Camera Functions and Digital Contact Sheets Assignment is shared under a CC BY 4.0 license and was authored,
remixed, and/or curated by Jessica Labatte and Larissa Garcia (Consortium of Academic and Research Libraries in Illinois (CARLI)) .
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CHAPTER OVERVIEW

2: Photography as Documentary

Photography was developed to create more accurate representations of the world than was possible through other art forms like
drawing or painting. Culturally, the most common use of the medium is to document and share our experiences and observations of
the world. In this chapter, students learn the technical skills needed to alter images so that they more accurately represent their
subject. Through specific exercises, students are introduced to the retouching workflow, in both Camera Raw and Photoshop, and
learn to make test strips and print images. For the chapter assignment, students consider the legacy of photography as objective
while creating photographs in the style of documentary photography.

Figure 2.1: Eugene Atget (negative 1912), Berenice Abbott (print later). Boulevard de Strasbourg, Corsets. (Public Domain via The
Getty)

Image Description: A black and white photograph of a window for a corset shop with 11 corsets on display.

Suggested Reading

Cartier-Bresson, Henri. The Decisive Moment. Simon and Schuster, 1952.
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2.5: Retouching Workflow in Photoshop
2.6: Printing from an Tmage File

2.7: Learning Checkpoint

2.8: Color Matching Exercise

2.9: One Perfect Print Exercise
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2.1: Overview of Retouching Workflow

Workflow refers to a sequence of steps needed to complete a project. For the photographic process, the order of steps—from taking
the picture to importing to retouching to sharing images—is important. While there are multiple ways to accomplish the same task
in Camera RAW and Adobe Photoshop, this chapter discusses the digital workflow processes used in class. Once you have learned
these steps, you may decide to modify, skip, or add steps to accomplish the desired outcome for your images.

Photographers choose how to edit their images, and these choices can work toward creating an accurate representation of a subject
or a more conspicuous manipulation or altered representation. If the photographer wants to accurately portray a scene in the style of
documentary photography, they will use minimal digital editing techniques. In this case, the edits serve the goal of making the
image look like the scene did when the image was captured, for example, removing any alterations in color, contrast, or exposure
that resulted from the camera settings.

Color variations come from the Kelvin scale, which shows that light has different color temperatures. Lights, cameras, computers,
and editing software like Photoshop use the RGB additive color mixing system; printers and inks use the CMYK subtractive
color mixing system. Because the screen is glowing light (RGB) and the print is ink on paper (CMKY), there will always be a
difference in appearance. Therefore, you need to pay attention to color management, the coordination of color across various
devices from cameras, computers, and editing software to printers and the various paper types to ensure that the color and tones of
your image are reproduced accurately.

Before you begin retouching or editing your photographs, keep in mind that starting with a high-quality image with good exposure
will result in better retouching and printing. Bad images require more retouching, similar to how a chef who uses old ingredients in
a dish will have to add more spices to compensate for the lack of freshness. Also, consider what your goals are for the image. This
may impact how you approach the retouching. While there are a variety of image editing software and philosophies about the best
image editing workflow, the following process represents the most suitable method for beginners.

The general steps of the retouching workflow are:

1. Save a copy of your image in a new location (PSD/TIFF Folder) so that the original DNG and the retouched version are saved
separately.

2. Global adjustments are the first edits a photographer makes. These are overall adjustments applied to the entire image. These
edits include adjusting the white balance, removing color casts or adjusting the overall color, adjusting the overall brightness,
and adjusting the overall contrast of the image.

3. Crop, rotate, and make lens corrections to the image to focus the retouching on only the pixels you want to keep in the
image. However, you should “crop in camera” and crop minimally on the computer. Depending on the lens used, there may be
perspective distortions that you should correct to ensure straight lines and to remove unwanted lens effects, i.e., chromatic
aberration and lens flare.

4. Remove spots or imperfections from an image using the healing brush or clone stamp.

5. Local adjustments are edits applied to specific areas of an image through selections. Photographers use selection tools to
isolate a portion of the image and apply an adjustment to the selected area without impacting the overall image. Use sections
and masking to adjust a specific area of the image for brightness, contrast, and/or color.

6. Prepare the image for output. These changes may include resizing, sharpening, color correcting, or adjusting the color space
for printing or sharing online.

This page titled 2.1: Overview of Retouching Workflow is shared under a CC BY 4.0 license and was authored, remixed, and/or curated by

Jessica Labatte and Larissa Garcia (Consortium of Academic and Research Libraries in Illinois (CARLI)) .

https://human.libretexts.org/@go/page/231844


https://libretexts.org/
https://creativecommons.org/licenses/by/4.0/
https://human.libretexts.org/@go/page/231844?pdf
https://human.libretexts.org/Courses/Northern_Illinois_University/Fundamentals_of_Photography_and_Creative_Practice/02%3A_Photography_as_Documentary/2.01%3A_Overview_of_Retouching_Workflow
https://human.libretexts.org/Courses/Northern_Illinois_University/Fundamentals_of_Photography_and_Creative_Practice/02%3A_Photography_as_Documentary/2.01%3A_Overview_of_Retouching_Workflow
https://creativecommons.org/licenses/by/4.0
https://human.libretexts.org/Courses/Northern_Illinois_University/Fundamentals_of_Photography_and_Creative_Practice/02%3A_Photography_as_Documentary/2.01%3A_Overview_of_Retouching_Workflow?no-cache
https://www.carli.illinois.edu/

LibreTexts"

2.2: Retouching Workflow in Camera Raw

Adobe Camera Raw is software that lets you import and enhance raw images. It is the first editing program used in the retouching
workflow because it allows you to do nondestructive editing, which means pixels are not discarded or lost in the editing process
and the quality of the image is maintained. (Destructive editing is an adjustment that permanently affects the pixels in an image.
These types of edits cannot be undone once the file is saved and closed.) Follow the editing process in Adobe by following the
arrangement of the tools, working from left to right, top to bottom, and use sliders to make adjustments to the images. An important
feature in the editing program is the histogram, which shows the tonal distribution of the image. Looking at the histogram as you
make adjustments will help you understand the different qualities of your image.

Figure 2.2.1: Before and After editing in Camera Raw. (Copyright; Amy Fleming. Adobe product screenshot reprinted with
permission from Adobe)

Image Description: Two screenshots of an image before and after editing in Camera Raw.

In Camera Raw, the retouching workflow is as follows.
1. Save As

e Choose Convert and save image.

e Destination: Save in a new location. Select your PSD/TIFF folder to save the retouched version.

o Under File Naming, enter the File extension: .TIF.

o For Format, select Tiff; Metadata: All; Compression: None.

¢ Under Color Space, for Space, select Adobe RGB (1998); for Bit depth, select 16 bit/channel for the best color.
o Under Image Sizing, do not change the default. Leave as your original MP. For Resolution, select 300 dpi.

o For Output Sharpening, check the box for Sharpen and select Screen.

2. Global adjustments

Start by adjusting the overall brightness to ensure that mid-tones, shadows, and highlights have appropriate detail. Tonal range in
the image is determined by the distribution of pixels, ranging from dark to light. The goal is to have a strong variety of tones across
the entire image. Move the exposure slider to the right to brighten the image; move it to the left to darken it.

Then make contrast adjustments to move highlights and shadows further away from each other. Contrast will vary depending on
the lighting in the image, the tones within the subject, and the artist’s preference. Too little contrast and the image will appear flat
and dull. Too much contrast, and the image will look surreal with little tonal variation of mid-tones. The right contrast will make
the image pop. The histogram of the image will look like two tall mountain peaks with slight tonal variation in the middle. Adding
contrast to your image causes the whites to appear brighter and the blacks to appear darker. Therefore, use the sliders for contrast,
highlights, shadows, whites, and blacks to refine each of the contrast adjustments. A low-contrast image typically does not have
true blacks or true whites, and the histogram is bunched in the middle. It is a good idea to apply contrast sparingly or even to wait
to apply contrast in Photoshop, which allows for more specific and subtle control.

Next, make color adjustments to remove color casts created by varying temperatures of light within a given scene. The first step
in color management is to choose the white balance appropriate for the image.

o As Shot: If you have custom white balance in the camera.
o Auto: If you forgot to adjust white balance in the camera, this setting will have the software do an automatic adjustment to the
image to determine an appropriate white balance.

@ 0 2.2.1 https://human.libretexts.org/@go/page/231846
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¢ Custom: Another option if you forgot to adjust white balance in the camera that allows manual selection of the part of the image
to balance from. Use the eye dropper tool to select the most neutral part of the image, a place that is white or grey.

o The other white balance options are for distinct types of light. Select one of these options if you photographed in fluorescent,
cloudy, daylight, or tungsten light.

The other options for adjusting color are the temperature and tint sliders. The temperature slider allows you to add more warmth or
coolness to an image by adding yellow or blue light. The tint slider allows you to add more coolness or warmth to the image by
adding green or magenta light.

Note that it may be necessary to go through the global adjustments, starting with brightness, then contrast, then color, until you are
satisfied with the outcome.

Other Slider Adjustments

o Highlights: Brighten or darken the pixels in the highlight range near the right side of the histogram.

o Shadows: Brighten or darken the pixels in the shadow range near the left side of the histogram.

o Whites: Adjusts the lightest part of the image, the far-right side of the histogram.

o Blacks: Adjusts the darkest part of image, the far-left side of the histogram.

o Texture: Smooths or enhances textures in the image without destroying the finer details or adding noise. This slider applies to
the mid-tone areas.

o Clarity: This is a more nuanced contrast that adds depth around mid-tones.

e Dehaze: Controls fog or mist.

o Vibrance: Increases unsaturated colors, which can help with a dull background.

o Saturation: Adjusts the saturation of all colors equally.

3. Crop, Rotate, and Lens Correction

To straighten images, use the Straight Edge tool. The constrain proportions setting allow you to maintain the height and width
(HW) dpi ratio of your image. Minimal cropping should take place on the computer because you are more likely to reduce the
image quality. To make the most compelling photographic images, crop in the camera while taking the photograph. Use the act of
taking the photograph as a way to frame within the camera using the view finder—you will make a better composition.

When taking photographs, the lens of the camera can sometimes lead to distortions of the subject that you may want to correct. The
optics menu allows you to remove image distortions caused by the camera lens. Two of the most common distortions are chromatic
aberration and perspective distortions.

A chromatic distortion, or color fringing, can occur when light travels through the lens. Sometimes the visible light spectrum's red,
green, and blue wavelengths separate as they travel through the glass of the lens and do not realign properly in the image. This
frequently occurs within areas of high contrast in an image, for example, where the bright sky and dark tree branches meet in an
image. Chromatic aberration causes a magenta or cyan halo of color around an object.

Lens distortions affect the shape of objects in the image. For example, wide-angle lenses cause strong bowing near the edges of the
frame so that a building may appear to have curved sides. You can use the geometry menu to correct for this by using the vertical
and horizontal sliders. When using these tools, it is a good idea to use the grid to align the perspective and ensure straight lines.

Most photographers do some geometry adjustments to create a more orderly and pleasing image. However, if these corrections do
not improve the image, skip them.

4. Spot Removal
The spot removal tool allows you to repair a selected area of an image.
Select the Type of spot removal.

o Heal blends pixels from one area with pixels from another area, essentially matching the areas, and is best for large areas of a
single color or gradients of color.

o Clone copies pixels and textures from one area and pastes them onto another area and is best for areas with patterns or straight
lines that you want to match exactly.

Select the size of the spot removal brush. Choose a brush that is slightly larger than the spot you are trying to remove. Move the
slider to the right to make the brush bigger; move the slider to the left to make the brush smaller.

@ 0 2.2.2 https://human.libretexts.org/@go/page/231846
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Feather determines the edge of the brush and how it blends with the surrounding area. For a hard solid circle, move the slider to
0%. To feather out or blend with the surrounding area, move the slider to 100%.

5. Local Adjustments

Because the options for local adjustments in Camera Raw are a little clunky, it is better to make these adjustments in Photoshop
using masking and selections.

6. Preparing for Output

Retouch the image using the steps above until the image looks “correct.” Correct images are free from unrealistic color casts, have
appropriate brightness in the mid-tones with details in both highlights and shadows, and have adequate contrast for the subject.
Once your adjustments are complete, select how to save, close, or continue working on the file.

e Done: This option will close the file with the adjustments applied and allow you to open the image in Camera Raw again to
make further changes.

o Open: This will open the image in Photoshop for further retouching. Be sure to save the file as a PSD or TIFF once you have
finished editing.

¢ Open Object: This option opens the image in Photoshop as a Smart Object so that you can move back and forth between
Camera Raw and Photoshop in the same image file.

This page titled 2.2: Retouching Workflow in Camera Raw is shared under a CC BY 4.0 license and was authored, remixed, and/or curated by
Jessica Labatte and Larissa Garcia (Consortium of Academic and Research Libraries in Illinois (CARLI)) .
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2.3: Making and Printing a Test Strip

Once you have made initial edits to the image, it is important to make a test strip because the image never prints exactly how it
looks on the computer screen. Test strips allow you to see a preview of the printed image before making an entire print, which not
only allows for adjustments before making the final print but also saves resources. Adobe Photoshop is the software used to make
test strips and to print images.

1. Open your image in Adobe Photoshop.

2. Go to File > New. Select Letter 8.5 x 11in in the Blank Document Presets.

3. Change your image size to fit the paper by going to File > Image Size. Uncheck Resample and then change the resolution to
300 dpi, which is the best resolution for printing. This setting also ensures that no pixels are created or deleted. Then, recheck
Resample and choose Bicubic Sharper (Reduction) in the drop-down menu, which refers to the algorithm that is used for the
resampling. Change the longest side of the image to 10.5. Note: the longest side can be either the width or height depending on
whether the image is oriented for portrait or landscape.

4. Next, select the Rectangular Marquee tool and use it to drag over a portion of the image that has a broad range of values (i.e.,
both highlights and shadows) and a portion of the main subject. Then, copy the selection (CMD+C for Macs; Ctrl+C for PCs).

Figure 2.3.12: Select the Rectangular Marquee tool and use it to drag over a portion of the image. (Copyright. Emma
Vitallo, NIU/MFA student. Adobe product screenshot reprinted with permission from Adobe)

Image Description: This is a screenshot that shows using the Rectangular Marquee tool to select a portion of the image (step
4).

5. Navigate to the blank 8.5 x 11in document and paste the selection (CMD+V for Macs; Ctrl+C for PCs) there.

https://human.libretexts.org/@go/page/231847
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Figure 2.3.13: Paste the selection onto the blank document (Copyright. Emma Vitallo, NIU/MFA student. Adobe product
screenshot reprinted with permission from Adobe)

Image Description: This is a screenshot that shows pasting the selection onto a blank document (step 5).

6. Rotate your test strip until the orientation matches the orientation of the print document.
7. Move the test strip over to make room for any additional adjustments or future test strips you might want to make.

Figure 2.3.14: Rotate and move the test strip over on the document. (Copyright. Emma Vitallo, NIU/MFA student. Adobe product
screenshot reprinted with permission from Adobe)

Image Description: This is a screenshot that shows the rotated selection at the far left of the document (step 7).

8. Once you are ready to print your test strip, in the menu bar, go to File > Print. The Photoshop Print Settings box will appear.

https://human.libretexts.org/@go/page/231847
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9. Under Printer Setup, make sure the Printer is set to the one you want to print from.
10. Under Color Management, for Color Handling, select Photoshop Manages Color.
11. For Printer Profile, select Premium Luster Photo Paper 260.
12. Under the selected printer, click on Print Settings.
13. Change the Paper Size to Custom Size.
14. To make a new custom size, select Manage Custom Sizes.
15. Click on the plus (+) icon in the bottom left corner to create a new custom size. Then, double-click on Untitled on the left to
rename the custom size accordingly.
16. For Margins, select your printer.
17. Change the width to 8.5 in and the height to 11 in. Then, click OK.
18. In the Print box, click on Printer Options to view the dropdown menu. Then, under Printer Options, click on Printer Settings.
19. For Page Setup, select Sheet, Borders — Maximum.
20. For Paper Source, select Manual Feed.
21. For Media Type, select Premium Luster Photo Paper (260).
22. After double-checking your settings, click OK.
23. In the Print box, click Save.
24. In the Photoshop Print Settings box, click Print.

This page titled 2.3: Making and Printing a Test Strip is shared under a CC BY 4.0 license and was authored, remixed, and/or curated by Jessica
Labatte and Larissa Garcia (Consortium of Academic and Research Libraries in Illinois (CARLI)) .
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2.4: Assessing Test Prints

To assess your test strip or prints, you will want to view them under a neutral light source and consider the brightness, color, and
contrast of the image. Ideally, you would use a light booth, which is designed to create the most accurate light scenario for
assessing prints.

Figure 2.4.1: Students assess their test strips. (CC BY-NC-ND; Drew Dzurko)

Image Description: Two students assess their test strips in a light booth.

Ask yourself the following questions. It is a good idea to make notes on the test print itself to aid you when editing the image in
either Camera Raw (for global adjustments) or in Photoshop (for local adjustments).

o Do the highlights have details?

o Do the shadows have details?

o Is there a wide range of tones across the image?

o Does the overall image feel bright enough?

¢ Does the image feel too warm?

¢ Too yellow?

e Too magenta?

e Too red?

e Does the image feel too cool?

o Too blue?

e Too green?

e Too cyan?

o If you have identified a color cast, use the color print viewing filters to test your hypothesis. These filters come in six colors
(red, green, blue, cyan, magenta, and yellow) and each color is represented in 10, 20, and 40 density values.

e Does the contrast look realistic?

o Do you need to add contrast?

o Is the contrast too intense?

This page titled 2.4: Assessing Test Prints is shared under a CC BY 4.0 license and was authored, remixed, and/or curated by Jessica Labatte and
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2.5: Retouching Workflow in Photoshop

The test printing process clarifies what additional global or local adjustments need to be made in Photoshop. You can go back to
Camera Raw to make global adjustments; however, if it is necessary to make local adjustments, it is easier to do so in Photoshop
(using selections and masking) than it is in Camera Raw. Photoshop layers stack adjustments on separate layers of an image; each
of these layers is independent, which allows for nondestructive editing of the image.

Think of the layers like the layers of a sandwich that are stacked in a particular order. The background layer is the base layer, the
bottom slice of bread, and the adjustment layers—the meat, cheese, and vegetables of the sandwich—sit on top of that. Start with
the layers for global adjustments (brightness, contrast, and color), and then if you need to make local adjustments, those layers will
go on top of the global adjustments.

Selections for local adjustments can be made based on size, shape, and color. When a selection is active, the changes made will
apply only to the selected area, leaving other areas unaffected. An area of the image is selected when it is in the black and white
“marching ants” frame.

If you make a mistake while making a selection, you can deselect the area and try again.

e To deselect: Command or Ctrl + d or Select > Deselect

If the area you want to change is large, it can be easier to select what you don’t want changed than what you want to change. In this
case, you need to invert the selection.

o To invert a selection: use Command or Ctrl + I or go to Select > Inverse

You can make four types of selections in Photoshop: geometric, freehand, edge-based, and color. It is important to choose the
selection tool based on the characteristics of the shape and color of the area you are trying to modify.

Marquee tools (rectangular and elliptical) are best for geometric selections. Because it is rare for any area or object in a
photograph to be a perfect square or rectangle, these tools are the least used by photographers.

The lasso, polygonal lasso, and magnetic lasso tools allow you to make freehand selections.

¢ Lasso tool: Click and drag to trace a freehand selection around an area. When you reach where you started, the selection will
close. Best used for areas without a defined edge.

o Polygonal lasso tool: Click to set anchor points for straight-line borders around an area. This tool is a good option for selecting
an object with a defined edge.

o Magnetic lasso tool: A combination of the lasso and polygonal tools, you can click to add additional anchor points or let the
tool identify the edge or area of contrast for you. Best tool to use when there is good contrast between the area you want to
select and its surroundings.

For edge-based selections, the quick selection tool is a good option because it automatically finds the defined edges of an image.
It is useful for masking hair or other objects with complicated edges. However, it is important to choose the appropriate settings for
the desired effect. For the quick selection tool, you can make a new selection, add to an existing selection, or subtract from a
selection. The selection will determine what adjustments to some or all of the following settings are needed.

¢ Brush size: How big the brush is.

o Hardness: How solid the edge of the brush is. The higher the number, the crisper the edge; the lower the number, the softer,
fuzzier the edge.

¢ Spacing: Controls how many selection points are dropped while you drag the brush over a set of pixels (similar to anchor
points). Use low spacing for selecting small areas. Use high spacing for selecting large areas.

o Sample All Layers: Creates a selection based on all of the layers in the image. This is generally a good option when working
with a multilayered image.

The magic wand tool makes color-based selections. This tool selects part of an image based on the similarity in pixel color and is
useful for selecting odd-shaped areas that share a specific range of colors. The tool is especially good when the area behind the
object you want to select is a different color than the object you are selecting. When using the magic wand tool, consider these
settings:

o Sample size: The default is 5 by 5 average.
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o Tolerance: 32 is the default setting, which selects all colors that are 16 levels lighter and 16 levels darker than the base color. Set
to 0 and it selects only one color; set to 255 and it selects all colors or the entire image.
o Contiguous: Selects only adjacent pixels.

Making selections by color range tends to have more thorough results. The color range settings are:

o Sampled colors: Use the eye dropper to select the desired color in the image.

¢ Localized color clusters: Selection limited to colors that are adjacent to each other.
o Fuzziness: Expands the reach of the selection process.

o Range: Adjusts how far across the image the selection is applied.

Anti-aliasing smooths the jagged edges of a selection by softening the color transition between the edge pixels and the background
pixels and is useful when cutting, copying, and pasting selections to make composite images. This option is available with the
lasso, marquee, and magic wand tools; however, it must be chosen before making the selection. Once a selection is made, you
cannot add anti-aliasing to it.

Feathering blurs edges by building a transition boundary between the selection and the pixels surrounding it. Note that blurring
can cause some loss of details at the edge of the selection. This option is available for the marquee and lasso tools when in use, or it
can be added to an existing selection. The feathering effect becomes apparent when you move, cut, or copy the selection.

Masking is a nondestructive way to hide parts of an image or layer without erasing them entirely. It is useful for making edits to
specific areas so that the entire layer is not affected. You can use any selection tool or adjustment layer to create a mask.

Select and Mask is the best option when the object you are selecting is very complicated because you can refine your local
adjustments without making a new selection. First, use one of the selection tools to make a section. Then, choose Select and Mask
from the menu bar to open the image in the Select and Mask editing window. Here, there are options to smooth the outline, feather,
contract, or expand the selection. Select from the Output To menu to apply the desired output to the selection.

Quick Mask tool allows any tool in Photoshop to become a selection tool. When selected, you can paint, use the gradient tool, etc.,
to make a mask that is applied to a selection, which then can be used with any adjustment layer.

Although capturing accurate colors in-camera saves post-production time, Photoshop is incredibly useful for color correction, and
the process is relatively simple. You can go back to Camera Raw to make global color adjustments but for local adjustments,
Photoshop is best. For example, if you notice a cyan color cast in the photograph, you can only remove it in Photoshop.

Figure 2.5.15: Grey Card in Use. (CC BY-NC-ND; Emma Vitallo, NIU/MFA student )

Image Description: A left hand with tattoos and pink painted fingernails holds up grey cards against a scene of white
sparkling garland in front of a picture in a white horse and butterfly frame on a gold tablecloth.

To get the most accurate color in post-production, using a grey card while you are taking pictures can be helpful. A grey card is a
small card that is 18% grey. If you have used a grey card in the image, you can follow the steps below to color correct.
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1. Open a test image that contains your grey card in Photoshop and create a Levels Adjustment Layer.
2. Next to the Levels histogram are three eyedroppers. Select the middle eyedropper and click on the grey card. Photoshop will
automatically adjust the image’s color levels.
3. To apply the grey card settings to other images taken in the same lighting conditions, in the Properties tab of the Levels
adjustment layer, click on the menu symbol or hamburger icon and select Save Levels Preset.
4. Name and save the preset and then open the other file(s) for editing.
5. For each image, find the Load Levels Preset from the drop-down menu of the Levels column and select the saved preset file to
apply it.
Until you have trained your eyes to be sensitive to identifying subtle color casts within an image, you should use a grey card to
ensure the most accurate color.

If you did not use a grey card, you will need to determine what color correction steps to take with the color viewing box. Once you
have visually identified the color casts in your image, you will use Photoshop adjustment layers to remove them. Although you
may think Color Balance is the best adjustment layer to use for removing color casts, this adjustment layer uses sliders that apply
the adjustment in a uniform amount across the entire image. It does not typically create a realistic solution to the color casts.

Curves is the best adjustment layer to use when color correcting because Curves applies the adjustment as a gradient, ensuring a
more realistic transition between colors. Curves also allows you to use an eyedropper tool to specifically target the area of your
image that shows the color cast on the histogram. Then you can use the drop-down menus to add or take away the red, green, or
blue light that is causing the color cast. You will drag the Curves line up or down depending on whether you want to take away or
add more of one color. If you want to restrict the change or limit it to certain parts of the histogram, you can place multiple points
along the curve to bend the adjustment so that it applies more or less. This precision lets you add more color in either the shadows,
highlights, or mid-tones without making a selection.

Some information in this chapter is adapted from Adobe's Photoshop User Guide, a valuable resource that provides more in-depth

information about the software.

This page titled 2.5: Retouching Workflow in Photoshop is shared under a CC BY 4.0 license and was authored, remixed, and/or curated by
Jessica Labatte and Larissa Garcia (Consortium of Academic and Research Libraries in Illinois (CARLI)) .
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2.6: Printing from an Image File

Once you are happy with the adjustments, you can now print your photograph. There are many types of inkjet photo paper
available on the market. Epson Premium Luster paper is used in beginning photography because it is an affordable, quickly drying
option that reproduces color with high saturation and bright contrast while preserving shadow detail. The surface has a luster finish
that catches light and adds to the traditional photographic quality.

Open your image in Adobe Photoshop.

Figure 2.6.16: Image in Photoshop. (Copyright; Emma Vitallo, NIU/MFA student. Adobe product screenshot reprinted with
permission from Adobe )

Image Description: A screenshot of an image in Photoshop to be printed.

. To change your image size, in the top menu bar, go to Image > Image Size.

. Make sure your resolution is 300 dpi.

. Change the width, the longest side of your image, to 10.5. Click OK when finished.

. To ensure your color profile is on Adobe RGB (1998), in the menu bar, go to Edit > Assign Profile. If the warning message
appears, click OK.

. If the Working RGB is not Adobe RGB (1998), click on the Profile dropdown menu and select Adobe RGB (1998). Then click
OK.

. Next, in the menu bar, go to File > Print. The Photoshop Print Settings box will appear.

. Under Printer Setup, make sure the Printer is set to the one you want to print from.

. For Layout, select the appropriate orientation, either portrait or landscape.

. Under Color Management, for Color Handling, select Photoshop Manages Color.

10. For Printer Profile, select Premium Luster Photo Paper 260.

11. Then, under the selected printer, click on Print Settings.

12. First, change the Paper Size to Custom Size.

13. To make a new custom size, select Manage Custom Sizes.

14. Then, click on the plus (+) icon in the bottom left corner to create a new custom size. Then, double-click on Untitled on the left

to rename the custom size accordingly.
15. For Margins, select your printer.
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16. Change the width to 8.5in and the height to 11in. Then, click OK.

17. In the Print box, click on Printer Options to view the dropdown menu. Then, under Printer Options, click on Printer Settings.
18. For Page Setup, select Sheet, Borders — Maximum.

19. For Paper Source, select Manual Feed.

20. For Media Type, select Premium Luster Photo Paper (260).

21. After double-checking your settings, click OK.

22. In the Print box, click Save.

23. Finally, click Print.

This page titled 2.6: Printing from an Image File is shared under a CC BY 4.0 license and was authored, remixed, and/or curated by Jessica

Labatte and Larissa Garcia (Consortium of Academic and Research Libraries in Illinois (CARLI)) .

@ 0 https://human.libretexts.org/@go/page/231859


https://libretexts.org/
https://creativecommons.org/licenses/by/4.0/
https://human.libretexts.org/@go/page/231859?pdf
https://human.libretexts.org/Courses/Northern_Illinois_University/Fundamentals_of_Photography_and_Creative_Practice/02%3A_Photography_as_Documentary/2.06%3A_Printing_from_an_Image_File
https://creativecommons.org/licenses/by/4.0
https://human.libretexts.org/Courses/Northern_Illinois_University/Fundamentals_of_Photography_and_Creative_Practice/02%3A_Photography_as_Documentary/2.06%3A_Printing_from_an_Image_File?no-cache
https://www.carli.illinois.edu/

Li breTexts*

2.7: Learning Checkpoint

Take a moment to review what you have learned so far and check your understanding with the questions below.

Figure 2.7.1: Marla Johnstone (NIU student). Morning Reflection, 2024. (CC BY; Marla Johnstone)

Image Description: Overhead photograph of wildflowers in a vase with their long shadow on the table.

? Question 2.7.1

What is the difference between Global and Local Adjustments?

a. Global: change around the world; Local: change around your community.
b. Global: edits made to a specific area of a photograph; Local: edits made to the entire photograph.
c. Global: edits made to the entire photograph; Local: edits made to a specific area of a photograph.

Answer

c. Global: edits made to the entire photograph; Local: edits made to a specific area of a photograph.

? Question 2.7.2

Choose all that apply. The first overall adjustments to be applied should be:

a. Retouching
b. Filters

c. Color

d. Contrast

e. Sharpening
f. Burning

g. Brightness

Answer

c. Color

d. Contrast

g. Brightness
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What is the correct order of general steps in the retouching workflow?

a. Save > Global adjustments > Local adjustments > Crop and rotate > Spot removal > Prepare image for output
b. Save > Global adjustments > Crop and rotate > Spot removal > Local adjustments > Prepare image for output
c. Save > Local adjustments > Crop and rotate > Spot removal > Global adjustments > Prepare image for output

Answer

b. Save > Global adjustments > Crop and rotate > Spot removal > Local adjustments > Prepare image for output

? Question 2.7.4

True or False: It is preferable to use Adobe Camera Raw as the first editing program for retouching because it allows for
nondestructive editing, which means pixels are not lost and the image quality is maintained.

Answer

True

? Question 2.7.5

Which program is preferable to use for local adjustments?

a. Adobe Bridge

b. Adobe Camera Raw
c. Adobe Photoshop
d. Apple Photos

Answer

c. Adobe Photoshop

? Question 2.7.6

Which of the following selection tools is the least used to edit photographs?

a. Lasso tool

b. Magnetic lasso tool

c. Rectangular marquee tool
d. Quick selection tool

e. Magic wand tool

Answer

c. Rectangular marquee tool

This page titled 2.7: Learning Checkpoint is shared under a CC BY 4.0 license and was authored, remixed, and/or curated by Jessica Labatte and

Larissa Garcia (Consortium of Academic and Research Libraries in Illinois (CARLI)) .
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2.8: Color Matching Exercise

Purpose and Description

Students practice making global and local adjustments for color correction. The exercise demonstrates the subjectivity and
objectivity of color and challenges students to make decisions about accurate color representation. Students photograph an object
and then bring it into the lab to use as a guide for color correction. The goal is to match the color in the photographic print to the
physical object.

Figure 2.8.1: Matching the color in the print to the physical object. (CC BY-NC-ND; Jessica Labatte)

Image Description: A hand holds a green iPad case with a yellow crisscross pattern next to the print of the object.

Tips for Success

e Set up an interesting composition. Pay attention to composition, exposure, focus, etc. The images must be technically correct
and interesting to look at! Still life, fashion, or product photography might be good avenues to explore for this project.

e Your series must have at least one object you can bring to class to use as a reference when working on these prints. For
example, if your subject is a still life, bring a cup, toy, or fabric from your composition. If you capture a portrait, bring the t-
shirt, sunglasses, or hat worn by the subject. If you photograph a landscape, bring a lawn ornament, a pinecone, or some other
small object that appears in the landscape.

o Pay attention to the quality, temperature, and direction of the light source.

o For this assignment try to customize White Balance using a grey card. This will result in the most accurate color in your
photograph and make color correction easier.

o Select an opaque object, because transparent objects will appear different depending on the lighting situation.

Requirements and Assessment

o Students will be evaluated on the quality of your images and the closeness to the color match.
o All images must be captured in RAW format.

o Include a contact sheet using Bridge of everything you photographed for this project with the one you printed highlighted.
e 8.5in x 11in; 5 images across, 6 rows down

o Include file names

o 1 digital file — PSD or TIFF

o Layered with your edits

o Named according to specified file conventions (i.e., Lastname_Firstname_assignment_01.psd)
o 1 inkjet print you made in our digital lab

o Technical success of the images and Camera Raw retouching

o Photographed on manual mode

o The subject is sharp and in focus

e Proper exposure
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o Appropriate depth of field, shutter speed
e ISO between 100—400
o Correct white balance

This page titled 2.8: Color Matching Exercise is shared under a CC BY 4.0 license and was authored, remixed, and/or curated by Jessica Labatte

and Larissa Garcia (Consortium of Academic and Research Libraries in Illinois (CARLI)) .
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2.9: One Perfect Print Exercise

Purpose and Description

In this exercise, students retouch one color photograph from the creative camera functions exercise using the adjustments in
Camera Raw. The photograph must be approved by your instructor before editing. After properly editing your photograph, make
test strips to ensure proper color correction, which must be approved by your instructor before printing the full image. After
approval, create one perfect inkjet print. Note that it may take several tries before you make the perfect print.

o Correct exposure and overall brightness

e Details are present in the highlights

o Neutral white balance created

e Color correct image for the environment

o Image contrast adjusted as appropriate for the image

e Dust or imperfections removed with healing brushes

o Files resized and prepared properly for printing

o Two digital files saved as PSD with specified naming convention (i.e., Lastname_Firstname_assignment_01.psd)

This page titled 2.9: One Perfect Print Exercise is shared under a CC BY 4.0 license and was authored, remixed, and/or curated by Jessica Labatte
and Larissa Garcia (Consortium of Academic and Research Libraries in Illinois (CARLI)) .
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2.10: The Decisive Moment Assignment

Purpose and Description

This assignment asks you to actively observe the world around you so that you can capture the Decisive Moment. Keep your
camera with you and try to take as many photographs as possible, because as Henri Cartier Bresson says, “You just have to live,
and life will give you pictures.” Your images should depict scenes that reveal larger narratives about the world you find yourself in.

Requirements and Assessment

¢ 6 photographs

o Technical success of the images and camera raw retouching: Photographed on manual, correct focus, appropriate depth of field,
appropriate shutter speed, correct exposure, correct white balance, shot with an ISO between 100—400.

o Composition: Use of formal elements of design to compose visually compelling images. Attention to edges of the frame,
straightness of lines, and success in the way the camera has been used to frame subjects.

o Images work together in a series

o Demonstrates a relationship between concept and visual form

This page titled 2.10: The Decisive Moment Assignment is shared under a CC BY 4.0 license and was authored, remixed, and/or curated by
Jessica Labatte and Larissa Garcia (Consortium of Academic and Research Libraries in Illinois (CARLI)) .
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3: Constructed Images

While much of early photography sought to document reality, the medium, even in its technological developments, has always
reflected a tension between the observed and the constructed. Photography, like other art mediums, ultimately represents the artist’s
many choices. These choices are particularly evident in staged photography, where the image has been arranged or constructed. In
this unit, students learn how to set up and use lighting, an important tool for staging images, to convey specific moods or support
concepts in their photographs. Studio lighting exercises give students experience with setting up backdrops, lights, light stands, and
gels. The assignment encourages students to think like a director with a specific intention and therefore take responsibility for every
aspect of the image in service to that intention.

Figure 3.1: Gordon Parks. Washington, D.C. Government charwoman, 1942. (No known restrictions; via Library of Congress)

Image Description: A black and white photograph of an older, African American woman holding a broom and a mop in front
of the American flag.

Constructed Images: Example Artists

Gregory Crewdson
Joan Fontcubera
LaToya Ruby Frasier
Laura Letinsky
Yasumasa Morimura
Vik Muniz

Cindy Sherman

Jeff Wall

Francesca Woodman
Jeong Mee Yoon
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3.5: Constructed for the Camera Assignment
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3.1: Introduction to Studio Lighting

Light is an essential component for capturing images. There are two types of light: natural light, which is produced by the sun and
varies depending on the time of day and the season, and artificial light (lamps, streetlights, candles, etc.), which is the light that
comes from artificial sources.

It is also important to understand the distinction between lights and lighting. Lights are the physical objects that emit light into the
world. Lighting refers to the intensity or quality of light, the effect lights have on a particular scene. Lighting can control the way a
viewer’s eye moves through an image, allowing you to tell a story by the way you illuminate different parts of the image.

Figure 3.1.17: A photographic studio with a backdrop, lights, and softboxes. (Publica Domain; Alexander Dummer via Wikimedia
Commons)

Image description: A photograph of a lighting studio setup with a backdrop, lights, and softboxes in a larger room with
curtains on the walls.

When it comes to artificial or studio lighting, photographers use either continuous lighting or strobe lighting. Each type of lighting
has its own visual effects and benefits (discussed below).

Strobe lights create short bursts of light. A strobe light, or flash, is a bulb that emits short bursts of bright light. Strobes are the
most powerful lights with bright intensity that most accurately replicate daylight in color temperature. However, when
photographing using strobe lights, it is necessary to view the image in the camera or on a computer screen to see the effect because
the light flashes so quickly.

Continuous lights, also known as constant lights, stay on during the session. When learning, continuous lights are the easiest to
work with because you can see the effect of the light and the shadows produced in real time without having to take a test exposure.
Most continuous lights are LED so they are affordable, easy to work with, and don’t get hot. In addition, the LED lights used in the
campus photo studio have a color temperature light control to shift from warmer light to cooler light. For the most accurate color,
use a middle setting between warm and cool. However, no matter what the color temperature light, it is necessary to white balance
for it.

In the real world, some kind of light is almost always available, called ambient light. An ambient light source can be natural or
artificial. When taking photographs, it is important to be as efficient as possible. First, assess the ambient lighting of the scene;
next, set the exposure in the camera based on this light; then, take a test exposure. Add additional lights as needed based on the test
exposure. The goal is to balance the ambient lighting and the added light so that you have the level of desired detail. Therefore, it
may be necessary to go back and forth between balancing the overall exposure of the scene and the added light. Where more light
is needed within the image will determine the role of the added light in the scene.

To modify the ambient lighting, or overall brightness of a scene, adjust the exposure with the camera settings. Aperture or shutter
speed controls the effect of ambient lighting within the image. To modify the overall brightness of the added light, increase the
intensity of the light or move it closer to the subject; decrease the intensity or move the light further away from the subject.
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When determining the lighting you want for your photo shoot, there are several factors to keep in mind. Consider the light
direction, or the relationship between the camera, the subject, and the light, which will impact where you add lights and can be
determined by the highlights and shadows present. For example, when shooting a professional studio portrait, the main light is
positioned at a 45-degree angle to create a natural triangle of shadow beneath the eye from the nose. If the angle is more than 45
degrees, the triangle will be too low, and the subject will look like they have raccoon eyes. If the angle is less, the triangle will be
too narrow, and the light will be too far to the side of the subject.

Also, think about the quality of lighting. Quality of lighting is determined by the light source and whether or not it is modified.
You describe the quality of light by observing the highlights and shadows within a scene. Lighting can be hard and high contrast,
which produces strong highlights and shadows with clearly defined edges. To create this effect, use a bright, unmodified light
source. To create soft and low contrast lighting that results in shadows with subtle definition and less intense highlights, the light
source must be modified. You can use a softbox or umbrella to create this effect.

The color temperature of a light source contributes to the aesthetics of an image. Because all light has color, you can choose how
to use white balance and the existing color of light to generate effects. Photographers, cameras, and software all use the Kelvin
scale to address the color temperature of a light source.

1000 2000 3000 4000 5000 6000 7000 8OO0 9000 10000 11000 12000
Figure 3.1.1: Color Temperature. (CC BY-SA 4.0; Bhutajata via Wikimedia Commons)

Image description: A horizontal color gradient image that transitions from a deep red on the far left to a light, almost white-
blue on the far right. The middle portion of the image shows a spectrum of progressively lighter orange, peach, and beige
shades. A numerical scale is marked along the bottom of the image, ranging from roughly 1,000 to 12,000.

The Kelvin scale measures color temperature, indicating whether a light source appears warm or cool.

o Lower Kelvin values (e.g., 2,700 K) produce warm, yellowish light, like that from incandescent bulbs commonly used in
homes.
o Higher Kelvin values (e.g., 5,500 K) emit cool, bluish light, similar to natural daylight.

You can also add colored gels to your lights to create unusual tones. The choices the photographers make about lighting contribute
to the overall concept and aesthetics of the image.

All light sources on a photo set are either key lights or fill lights. The key light is the main light on a subject and the most powerful
light in the scene. Fill lights are the supporting light sources. The photographer’s decision about the style of the image will
determine the positions of the key light and fill lights to achieve the desired effect.

How the light is arranged determines the mood of the image. For example, high key lighting creates large white areas that are light
and bright with white and grey tones that can translate to upbeat, youthful, or happy feelings. Low key lighting produces large dark
areas that can express somber, serious, or more formal tones.

A one-light setup is typically used to create a dramatic portrait or still life and is usually a low-key lighting situation. However, if
the shadow is too dramatic in this setup, you can use a reflector, a tool to redirect light on a subject, to create fill light or produce
more detail in the shadows.

A three-light setup consists of a key light, a fill light, and one additional light and is best used to create a more balanced image
with more light. In the traditional three-light setup, the key light should be a large source and placed where it lights the main
subject, usually from a 45-degree angle. The fill light, or secondary light, is typically positioned opposite the key light with half the
intensity.
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#3 Back Light Standard
Three-Point
Lighting

#1 Key Light #2 Fill Light

Figure 3.1.18: Tllustration of three-point light set-up. (Public Domain via Wikimedia Commons)

Image description: Illustration of a standard three-point light setup that consists of a key light, fill light, and a back light, all
focused on the object.

The third light in a three-light setup is often either a hair light or back light. A hair light separates the subject from background,
adding dimension to the image. For example, if taking the portrait of a subject with dark hair against a dark background, a hair light
makes the dark hair distinct from the dark background. A back light separates the tones and subject from the background by
adding depth and creating a pleasing glow or halo around the figure.

o If possible, use the natural light from windows.

o Using a lamp with a shade will give your image soft and low-contrast lighting.

o Removing the shade from a lamp will give you hard and high-contrast lighting.

o You can purchase inexpensive lights from the hardware store (i.e., puck lights, handheld LED constants, clamp lights).

This page titled 3.1: Introduction to Studio Lighting is shared under a CC BY license and was authored, remixed, and/or curated by Jessica
Labatte and Larissa Garcia (Consortium of Academic and Research Libraries in Illinois (CARLI)) .
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3.2: Learning Checkpoint

Take a moment to review what you have learned so far and check your understanding with the questions below.

Figure 3.2.1: Sasha Edwards (NIU/BFA student). Radical Color, 2025. (Copyright; Sasha Edwards)

Image Description: Close-up of a toy car. The car looks metallic with pink and blue lighting. Water droplets are visible on the
surface of the car, creating a reflective effect.

? Question 3.2.1

Match the term with its definition.

a. Lights

b. Lighting

c. The physical objects that emit light into the world.

d. The intensity or quality of light; the effect lights have on a particular scene.

Answer
a. Lights = c. The physical objects that emit light into the world.

b. Lighting = d. The intensity or quality of light; the effect lights have on a particular scene.

? Question 3.2.2

Which of the following is not an example of artificial light?
a. Lamps

b. Candles

c. LED bulbs

d. Moonlight

Answer

d. Moonlight
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? Question 3.2.3

True or False: Continuous lights are the easiest to work with because you can see the effect of the light and the shadows
produced in real time.

Answer

True

? Question 3.2.4

Which type of lighting can express a somber or more serious mood?
a. High key lighting

b. Low key lighting

c. Ambient light

d. Strobe light

Answer

b. Low key lighting

? Question 3.2.5

Which of the following lights are optional in a three-light setup? Choose all that apply.
a. Key light

b. Fill light

c. Hair light

d. Back light

Answer

c. Hair light
d. Background light

This page titled 3.2: Learning Checkpoint is shared under a CC BY license and was authored, remixed, and/or curated by Jessica Labatte and
Larissa Garcia (Consortium of Academic and Research Libraries in Illinois (CARLI)) .
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3.3: Three-Light Setup for Portraits Exercise

This exercise allows students to learn how to direct a portrait session while refining technical and compositional aspects of their
images using a three-light setup.

Figure 3.3.1: Portrait of Janelle. (Copyright; Amy Luehrs)

Image Description: A woman with wavy brown hair with purple highlights and short bangs is shown from the chest up
against a bright blue background. She wears a yellow and black patterned top with a collar and zipper, and tattoos are visible
on her upper arms. She smiles slightly and looks just right of the camera.

Instructions: Create a portrait (self or of another person) using a three-light setup. You must utilize a key light, fill light, and one
additional light source.

Figure 3.3.1: Three-light Setup for Portraits. (Copyright; Amy Luehrs)

Image Description: A woman sits on a stool in a dark studio with a bright blue backdrop. She wears a short-sleeved yellow
and black patterned dress. Three lights are positioned to illuminate the woman.

Tips for setting up your studio lighting for portraits:

¢ Your subject should be as far away from the background as possible.
o If the subject wears eyeglasses, position your light to avoid glare.
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e Don’t forget to bracket!

This page titled 3.3: Three-Light Setup for Portraits Exercise is shared under a CC BY license and was authored, remixed, and/or curated by

Jessica Labatte and Larissa Garcia (Consortium of Academic and Research Libraries in Illinois (CARLI)) .
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3.4: Light Modulators Exercise

“The function of a light modulator is to catch, reflect, and modulate light. A flat surface
does not modulate, it only reflects light, but any object with combined concave-convex or
wrinkled surfaces may be considered a light modulator since it reflects light with varied
intensity depending upon its substance and the way its surfaces are turned toward the

light source.” --Lazlo Moholy-Nagy.

Create a still life inspired by Lazlo Maholy-Nagy using objects that reflect and refract light. Use constant lighting and colored gels
to create interesting patterns and shadows. Your goal is to create engaging photographic abstractions that focus on formal qualities
of light, color mixing, and form.

Figure 3.4.19: Lészl6 Moholy-Nagy, Light Space Modulator, 1922-1930, gelatin silver print, 25.3 cm (about 9.96 in) x 18 cm
(about 7.09 in), The Museum of Fine Arts, Houston, museum purchase funded by Lucile Bowden Johnson in honor of Frances G.
McLanahan and Alexander K. McLanahan (Public Domain)

Image description: A black and white image of a metal contraption made of circles and rods with light reflecting off of it.

Instructions:

1. Choose a box (either from home or one in the studio) that will serve as your light modulator. It will be painted white on the
inside to allow the most intense reflection of light on the interior surfaces and subtle shades of colored light to be visible. Think
of the box as a stage. There should be holes on the sides of the box to allow light to enter and interact with the forms inside and
a place for your camera to enter the box.

2. Select a variety of objects to fill the box. At least one of these must be an object that you created with the 3D printer. It is best to
select white objects, but they can also be transparent, translucent, or opaque. Look for items that have interesting textures and
dimensions (Styrofoam, wax paper, cellophane, plastic packaging, glass vases, plastic or glass bottles, crystal balls, diamonds,
quartz crystals, onions, snowballs, balloons, bubbles, paper cups, golf balls, whiffle balls, tinsel, icicles, etc.). You may also
want to try using mirrors, aluminum foil, or silvery reflective objects.

3. Set up your still life of objects inside the box. Consider the elements of design and composition and how your camera will
photograph the scene. Once you are satisfied with the design of your light modulator, begin lighting the objects with the LED
puck lights. Try using various color combinations of light. Notice how the colors blend and mix. Pay attention to the direction
of light, the shadows, and any interesting forms or shapes.

4. Once you feel compelled, begin photographing. Your goal is to create interesting photographic abstractions that focus on formal
qualities of light, color mixing, and form.
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Tips for Photographing Your Light Modulator

o Get close! Physically move your camera closer to the Light Modulator. Get so close that your lens will not focus properly. Yes,
this is encouraged.

e Move the objects in the scene. Don’t be afraid to make changes, to add or remove anything throughout your photographing
process.

o Change up the gel colors! Continue to consider color theory throughout your photographing process (colors that are primary,
secondary, complementary, or opposite).

o Don’t forget to bracket.

This page titled 3.4: Light Modulators Exercise is shared under a CC BY license and was authored, remixed, and/or curated by Jessica Labatte
and Larissa Garcia (Consortium of Academic and Research Libraries in Illinois (CARLI)) .
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3.5: Constructed for the Camera Assignment

Purpose and Description

For this project, students are challenged to take a different approach to photography than previously discussed. Instead of going out
into the world to take photographs of what you find or observe, you will think more like a director overseeing every aspect of the

photograph. Explore how your stylistic choices paired with intentionally selected subjects can reveal larger themes and conceptual
thinking.

Figure 3.5.1: Mari Hernandez (NIU student). Lighting, 2024. (CC BY-NC-ND; Mari Hernandez)

Image Description: Two pieces of a stark white mannequin, the buttocks and hand, sit on a white pedestal with a white
background.

Requirements and Assessment
o 6-8 digital files — PSD or TIFF:
o Layered with your edits
o Named according to specified file conventions (i.e. Lastname_ConstrucedforCamera01.psd)
e 6-8 inkjet prints you made in our digital lab
o Technical success of the images and Camera Raw retouching:
o Shot on Manual Mode
Subject is sharp and in focus
Proper exposure
Appropriate depth of field, shutter speed
ISO between 100—400
o Correct white balance

o O O o

e Successful compositions that address the elements of design and concept:
o Images work together as a series
o Images demonstrate a relationship between concepts and visual form
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This page titled 3.5: Constructed for the Camera Assignment is shared under a CC BY license and was authored, remixed, and/or curated by

Jessica Labatte and Larissa Garcia (Consortium of Academic and Research Libraries in Illinois (CARLI)) .
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CHAPTER OVERVIEW

4: In Conversation With

An important aspect of creating photographic art is the recognition that art is an ongoing conversation that reflects not only art
history but also culture, science, politics, and the world around the photographer. Therefore, it is necessary for you to know how to
access and explore through research the relevant discourse and knowledge that can be used both as inspiration and as context. In
this chapter, you will learn basic information literacy skills to research photographic artists and then create work that is inspired by
or responds to the photographer you researched. Ultimately, students enter into a visual conversation and begin to learn to discuss
photographs for their formal, aesthetic, and conceptual qualities to develop information and visual literacy skills.

Figure 4.1: Dorothea Lange 's "Migrant Mother," 1936. (No known restrictions; via Library of Congress) and Jessica
Labatte's Heart Tether, 2021 (Copyright; Jessica Labatte)

Image Description: On the left, a black and white photograph from the Great Depression features a weary woman with a
furrowed brow and a distant gaze, holding a baby while two other children cling to her, hiding their faces. On the right, a
color photograph of a weary woman looking at the camera, hugging her small child with a colorful background and
sunflowers.

Example Artists: In Conversation

Dorothea Lange and Katy Grannan

Cindy Sherman and Claude Cahun

Dawoud Bey and Carrie Mae Weems

Kelli Connell and Natalie Krick and Edward Steichen
Kenneth Josephson, Lisa Oppenheim, and Xaviera Simmons
Timothy H. O’Sullivan and An-My Le

Josef Albers and Jessica Eaton

Reference

Association of College and Research Libraries. “Framework for Information Literacy for Higher Education,” 2016.
https://www.ala.org/acrl/standards/ilframework.

4.1: Research and Citing Sources

4.2: Learning Checkpoint
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4.3: Photographer Presentation Assignment

4.4: In Conversation with Assignment

This page titled 4: In Conversation With is shared under a CC BY 4.0 license and was authored, remixed, and/or curated by Jessica Labatte and

Larissa Garcia (Consortium of Academic and Research Libraries in Illinois (CARLI)) .
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4.1: Research and Citing Sources

Creating art is often the result of new insights or interpretations of previous information. Therefore, knowing about photographers
from the past as well as contemporary artists allows you to participate in the larger, ongoing conversation about photography as an
artistic medium and the world we live in. By recognizing the contributions of other thinkers and artists, you contextualize your
work and place it in relation to the larger context of art history, ideology, and social communities.

No matter where you get information, images included, or how you use the information, you must provide a citation so that you are
giving credit to the original ideas of others. Those in the arts field most often use the Chicago Manual of Style (CMOS). For
images, while it may not be possible to find all the information, you should provide as much information as possible. For formal
papers and presentations, provide both a caption for the image and a bibliography entry.

References

[1] Meeks, Amanda, Larissa Garcia, Ashley Peterson, and Alyssa Vincent. (2017). “CREATE: Adapting the Framework to Studio
Art disciplines.” College & Research Libraries News 78, no. 10: 554. https://doi.org/10.5860/crIn.78.10.554.

In addition to the example images and corresponding CMOS captions and citations below, you will notice image descriptions
set off by brackets to minimize confusion with the caption examples. Image descriptions provide textual descriptions of an
image or graphic so that people who use screen readers get the information. Best practices for digital publishing require image
descriptions and alt text (brief image description included for the image file), important for making an electronic document
accessible. Image descriptions have been provided for all of the images included in this textbook. For more information on
writing image descriptions, go to the Guide to Image Descriptions from AccessiblePublishing.ca.

Chicago Manual of Style (17th edition): Basic Guidelines

e An illustration number may be separated from the caption by a period or a space. "Figure" may be abbreviated or spelled out.

o Captions and citations should include the artist's name, title of work (italicized), year the work was created, and where it is
located. Include additional information, such as medium, measurements, and rights/licensing information if available.

e Be sure to include the date accessed and the URL if the source is online.

o Be consistent with how captions are displayed.

Chicago Style Citation Format for an Image

o Caption: Fig. #. Artist’s name, Title, Date, Medium. Measurements. Location: publisher. (Rights/licensing.)
o Bibliography: Artist’s name (last name, first name). Date. Title. Medium. Measurements. Location: publisher.
(Rights/licensing.)

For example, below is an image downloaded from the Art Institute of Chicago with a caption.
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Figure 4.1.20: Lewis Wickes Hine. Saide Pfeifer, a Cotton Mill Spinner, Lancaster, South Carolina. 1908. Gelatin silver print. 8 x 9
15/16 in. Art Institute Chicago (Public Domain via AIC)

[Image description: Black and white image from the early 1900s of a little girl standing in front of factory loom that is
spinning cotton.]
The CMOS citation for the bibliography would be

Hine, Lewis Wickes. Saide Pfeifer, a Cotton Mill Spinner, Lancaster, South Carolina. Gelatin silver print. 8 x 9 15/16 in. Art
Institute Chicago. Accessed January 10, 2024. https://www.artic.edu/artworks/23336/sadie-pfeifer-a-cotton-mill-spinner-lancaster-
south-carolina.

Other Image Citation Examples
Image scanned from a book
Caption:

Fig. 1. Alice Neel, Nancy and the Rubber Plant. 1975, Oil on canvas, 203.2 x 91.4 cm. The Estate of Alice Neel. In Ann
Temkin et al. Alice Neel. New York: Harry N. Abrams, 2000. Plate 64.

Bibliography entry:

Neel, Alice. Nancy and the Rubber Plant. 1975, Qil on canvas, 203.2 x 91.4 cm. The Estate of Alice Neel. In Alice Neel
edited by Ann Tempkin, New York: Harry N. Abrams, 2000. Plate 64.

Image downloaded from museum website
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Figure 4.1.21: Julia Margaret Cameron, Julia Jackson. 1867. Albumen silver print from glass negative, 27.4 x 20.6 cm. The
Metropolitan Museum of Art, New York. Accessed January 10, 2024, https://www.metmuseum.org/art/collection/search/267426.

(Public Domain)
[Tmage description: Haunting black and white portrait photograph of a woman with long hair and a neutral expression, with

half of her face in shadows.]

Bibliography entry:
Cameron, Julia Margaret. Julia Jackson. 1867. Albumen silver print from glass negative, 27.4 x 20.6 cm. The Metropolitan
Museum of Art, New York. Accessed January 10, 2024. https://www.metmuseum.org/art/collection/search/267426.

Image downloaded from image-sharing websites (i.e., Flickr Commons)

il

Figure 4.1.22: Thomas Eakins, William Rudolf O'Donovan. 1981, Black and white photographic print, 6 x 8 cm. Archives of
American Art, Smithsonian Institution, Washington, DC. Accessed January 9, 2024,
http://www.flickr.com/photos/smithsonian/2547841439. (No known copyright restrictions)

[Image description: Black and white photograph of sculptor William Rudolf O'Donovan next to a bust of a bearded man.]

https://human.libretexts.org/@go/page/233343


https://libretexts.org/
https://creativecommons.org/licenses/by/4.0/
https://human.libretexts.org/@go/page/233343?pdf
https://www.metmuseum.org/art/collection/search/437986
https://www.metmuseum.org/art/collection/search/437986
https://flic.kr/p/4T9muF

LibreTexts"

Bibliography entry:

Eakins, Thomas. William Rudolf O'Donovan. 1981, Black and white photographic print, 6 x 8 cm. Archives of American Art,
Smithsonian Institution, Washington, DC. Accessed September 29, 2009.
https://www.flickr.com/photos/smithsonian/2547841439.

Image downloaded from Flickr (personal images uploaded by others)

Figure 4.1.23: Fig. 5. Vienna Rathaus. 1872-1883 by Friedrich von Schmidt. Photography by Harshil Shah, Vienna - Rathaus, May
31, 2009, Flickr. Accessed January 9, 2024, http://www.flickr.com/photos/harshilshah/3823135957. (CC BY-ND)

[Image description: Photograph of exterior hallway with stone columns and black iron and glass hanging lanterns.]
Bibliography entry:

Shah, Harshil. Vienna - Rathaus, May 31, 2009, Flickr. Accessed January 9, 2024,
http://www.flickr.com/photos/harshilshah/3823135957.

Additional Source Citation Examples
Book

Thomas, Mickalene. 2018. Mickalene Thomas: I Can’t See You Without Me. Wexner Center for the Arts, The Ohio State
University.

Scholarly Article

Matsumura, Kimiko. “The Death of Painting and Its Afterlife in Morimura Yasumasa’s Portrait (Futago).” Arts (Basel) 12,
no. 5 (2023): 196.

Article from an Online Reference Database

Falconer, Morgan. "Morimura, Yasumasa." Grove Art Online. 10 Dec. 2000. Accessed 25 Oct. 2023.
https://doi.org/10.1093/gao/9781884446054.article. T097151.

Film
Sotheby’s. Sotheby’s Spotlight: The Pilara Foundation Collection: Dorothea Lange and Katy Grannan, 2023. YouTube.
Video, 3:38. Accessed September 12, 2023. https://youtu.be/ovHINcYOFiM?si=W3mcMPHddWO2rXhi

Website

Gaylord, Kristen. “Cindy Sherman.” MoMA. 2016, accessed January 2, 2024. https://www.moma.org/artists/5392
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This page titled 4.1: Research and Citing Sources is shared under a CC BY license and was authored, remixed, and/or curated by Jessica Labatte
and Larissa Garcia (Consortium of Academic and Research Libraries in Illinois (CARLI)) .
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4.2: Learning Checkpoint

Take a moment to review what you have learned so far and check your understanding with the questions below.

? Question 4.2.1

True or False: You only need to cite textual information you find, not images that you include in papers or presentations.

Answer

False

? Question 4.2.2

What citation style is most often used in the arts?

a. MLA
b. APA
c. Chicago
d. AND

Answer

c. Chicago

? Question 4.2.3

True or False: When citing images, you should include a caption AND a citation for the bibliography or reference list.

Answer

True

? Question 4.2.4

What information should be included if it is available but is not necessary for a proper caption or image citation?

a. Artist’s name

b. Title of the work
c. Date created

d. Size

Answer

d. Size

This page titled 4.2: Learning Checkpoint is shared under a CC BY license and was authored, remixed, and/or curated by Jessica Labatte and
Larissa Garcia (Consortium of Academic and Research Libraries in Illinois (CARLI)) .
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4.3: Photographer Presentation Assignment

Purpose and Description

This assignment is designed to introduce students to a variety of photographic artists. Each student will choose one photographer to
research and then present about the artist in class using PowerPoint.

Figure 4.3.24: Alfred Stieglitz. Dorothy Norman, 1932. (Public Domain via Wikimedia Commons)

Image description: Black and white headshot of photographer Dorothy Norman. She has a neutral expression on her face and
wears a dark hat that covers most of her hair.

Requirements & Assessment

The presentation should address the following topics:

Biographical details.

Historical factors that may have influenced the work.

Technological factors that may have influenced the work.

Significant images: Show the evolution of the photographer’s practice. Images must include captions in Chicago style citation
format.

Ideas and concepts found in the photographs: What makes this photographer’s work unique? What other artists and
photographers was your photographer in conversation with?

The PowerPoint must include a bibliography in Chicago style citation format of at least five sources: 1 book, 1 website, 1 article, 2
sources of your choice (documentary, interview, etc.); include captions and citations for the images.
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Photographers

Note that this is not an exhaustive list of potential subjects, nor does it include the artists listed as examples in the previous

chapters.

Aaron Siskind
Abelardo Morell
Adam Fuss

Aimee Beaubien
Albert Renger-Pasch
Alec Soth

Alejandro Cartagena
Alexander Rodchenko
Alessandra Sanguinetti
Alfred Stieglitz

Allan Sekula

Alvin Langdon Coburn
Andre Kertesz
Andreas Gursky
Andres Serrano

Andy Goldsworthy
Anna & Bernard Blume
Anna and Bernhard Blume
Anna Atkins

Annie Leibovitz

Ansel Adams

August Sander

Awol Erisku

Barbara Crane

Barbara Kasten
Barbara Kruger
Barbara Probst
Barbara Rosenthal

Bea Nettles

Ben & Hilda Becher
Berenice Abbot

Bill Brandt

Bill Owens

Brassai

Brian Ulrich

Bruce Davidson

Bruce Nauman
Carmen Winant
Carolyn Drake
Catherine Opie

Cecil Beaton

Christian Schad
Christopher Williams
Chuck Close

Clarence John Laughlin
Collier Schorr

Corinne Day
D’Angelo Lovell Williams

@0

Gordon Matta-Clark
Gregory Bojorquez
Guanyu Xu

Gustave Le Gray
Hank Willis Thomas
Hannah Hoch
Hannah Wilke

Hans Bell

Harry Callahan
Helen Levitt

Helen Van Meene
Helmut Newton
Henri-Cartier Bresson
Hiroshi Sugimoto
Ilse Bing

Imogen Cunningham
Irving Penn

Ishan Tankha

Jack Delano

Jacob Riis

James VanDerZee
James Welling
Jason Lazarus

Jerry Ulesmann

Jess T. Dugan
Jessica Labatte

Jill Greenberg
Jimmy DeSana

Joan Fontcuberta
Joel Sternfeld

Joel Peter Witkin
John Baldessari
John Heartfield
John Opera

John Pfahl

John Stezaker

John Szarkowski
Josef Koudelka
Josef Sudek

Julia Margaret Cameron
Justine Kurland
Karl Blossfeldt

Ken Fandell

Larry Clark

Larry Sultan

Lauire Simmons
Laura Aguilar
Lauren Greenfield

Myriam Boulos
Nadar

Nakeya Brown
Nan Goldin

Neil Winokur

Nic Nicosia
Nicephore Niepce
Nicholas Nixon
Nobuyoshi Araki
Odette England

O. P. Sharma

Oscar Gustave Rejlander
Oscar Nerlinger
Paul D’ Amato

Paul Graham

Paul Mpagi Sepuya
Paul Outerbridge
Paul Strand

Peter Hujar
Philip-Lorca diCorcia
Prarthna Singh
Ralph Eugene Meatyard
Renee Cox

Renike Dijkstra
Reynaldo Rivera
Richard Avedon
Richard Learoyd
Richard Misrach
Richard Prince
Rinko Kawauchi
Robert Adams
Robert Capa
Robert Frank
Robert Heinecken
Robert Mapplethorpe
Rodrigo Valenzuela
Roger Fenton

Roni Horn

Ruben Ortiz Torres
Sally Mann

Sandy Skoglund
Sara Van Der Beek
Sarah Charlesworth
Sebastiao Salgado
Shannon Ebner
Sharon Core
Sherrie Levine
Sophie Calle
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Daidd Moriyama
Daniel Gordon
Danny Lyon
David Hilliard
David Hockney
David LaChapelle
David Levinthal
Deana Lawson
Deborah Willis
Diane Arbus

Dora Maar
Dorothy Norman
Doug Dubois
Duane Michaels
Eadweard Muybridge
Edward Burtynsky
Edward Weston
E.J. Bellog

El Lissitzky

Elle Pérez

Elliot Erwitt
Ernest Haas
Eudora Welty
Eugene Atget

Eve Arnold
Francis Joseph Brugiere
Frederick Sommer
Garry Winogrand
Gillian Wearing

Lazlo Maholy Nagy
Lee Friedlander
Leslie Hewitt

Lewis Baltz

Lewis Carroll

Lewis Hine

Lisette Model

Liz Seschennes
Lorna Simpson
Louis Carlos Bernal
Louise Lawler

Luigi Ghirri

Lyle Askton Harris
Lynne Cohen

Man Ray

Manuel Alvarez Bravo
Marcel Duchamp
Margaret Bourke White
Mariah Robertson
Marion Post Wolcott
Martha Rosler
Martin Parr
Marzena Abrahamik
Masahisa Fukase
Mathew Brady

Matt Lipps

Maurice Tabard
Min Kim Park
Minor White

Mitch Epstein
Miyako Yoshinaga

Srinivas Kuruganti
Stephen Shore
Steven Molina Contreras
Susan Meiselas
Taryn Simon

Terry Evans
Thomas Struth
Tierney Gearon
Tina Barney

Tina Modotti

Tod Papageorge
Todd Hido
Tokihiro Saito
Tommy Kha

Tseng Kwong Chi
Uzma Mohsin
Viviane Sassen
Walker Evans
Wendy Red Star
Whitney Bradshaw
William Eggleston
William Wegman
Wolfgang Tilmnans
Wynn Bullock
YAMAMOTO MASAO
Yousuf Karsh
Zackary Drucker
Zanelle Muholi
Zeke Berman

Zoe Leonard

Zoe Strauss

This page titled 4.3: Photographer Presentation Assignment is shared under a CC BY license and was authored, remixed, and/or curated by

Jessica Labatte and Larissa Garcia (Consortium of Academic and Research Libraries in Illinois (CARLI)) .
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4.4: In Conversation with Assignment

Purpose and Description

Use the research and information you learned about your photographer to make compelling and creative images inspired by them.
Whether it’s their style, similar locations or subjects they photographed, or even a specific way they made photographs, your
audience should be able to easily identify the visual conversation you are having with the artist through the similarities between
your images and theirs.

Figure 4.4.1: Kalen Cottrell (NIU Student). Cottrell_Connell06, 2024. In conversation with Kelli Connell's Double Life series. (CC
BY-NC-ND; Kalen Cottrell)

Image Description: Two people with long, wavy blonde hair sit next to each other on a wood deck with their backs to the
camera. The person on the left has their head on the other's shoulder.

Requirements & Assessment
o All images must be shot in RAW format.
o Contact Sheet using Bridge of everything you photographed for this project with the 8 you decided to print highlighted.
e 8.5in x 11in; 5 images across, 6 rows down
¢ Include file names.
o 8 digital files — PSD or TIFF
o Layered with your edits.
o Named according to specified file conventions (i.e. Lastname_PhotographersLastname01.psd).
o 8 inkjet prints you made in our digital lab.
o Technical success of the images and Camera Raw retouching;:
o Shot on Manual
o Subject is sharp and in focus
o Proper exposure
o Appropriate Depth of Field, Shutter Speed
o ISO between 100400
o Correct White Balance

e Successful compositions that address the elements of design and concept.

o Images work together as a series.
o Images demonstrate a relationship between concepts and visual form.

This page titled 4.4: In Conversation with Assignment is shared under a CC BY license and was authored, remixed, and/or curated by Jessica
Labatte and Larissa Garcia (Consortium of Academic and Research Libraries in Illinois (CARLI)) .
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CHAPTER OVERVIEW

5: Appendices

The following appendices are designed to complement the content of the main chapters and provide practical tools and guidance to

enhance your photographic practice: writing effective artist statements and participating in constructive critiques.

o Appendix A: Artist Statements: Includes the definition and purpose, examples, and tips for writing your artist statement and
activities for drafting and peer review.

o Appendix B: Critiques, or CRITs: Includes tips for preparing for critiques as both the artist receiving feedback and a
participant giving feedback.

These resources will help you articulate your artistic voice and make the most of feedback, supporting your development as a
photographer.

5.1: Appendix A- Artist Statements
5.2: Appendix B- Critiques, or CRITs

5: Appendices is shared under a CC BY license and was authored, remixed, and/or curated by LibreTexts.
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5.1: Appendix A- Artist Statements

What is an artist statement?

An artist statement is text written by the artist that helps the audience understand the creative work. It can discuss an individual
work, a series of works, or an entire artistic practice, and it often includes themes, content, influences, and/or process for the work.
Artist statements can vary in length from one sentence to several paragraphs depending on the purpose and audience.

Why write an artist statement?

An artist statement accompanies your work in professional settings, essentially representing you and your work when you are not
there. Tt is often required when submitting applications for exhibitions, grants, and jobs, and it should be available on your
professional website.

What does an artist statement include?

In the artist statement, the artist describes themes (ideas, issues of concern), content (subject matter, visual imagery, symbolism,
conceptual meanings), and form (material choices, process). It is also an opportunity for the artist to describe the creative
conversation they are entering with the work by defining the cultural context in which the work should be viewed. Defining context
is done by establishing relationships between the artist’s work and that of other artists, historically and contemporarily and by
linking the ideas present in the work to a larger discourse (e.g., feminist, philosophical, political, psychological).

X Topics to address in your Artist Statement

e Artist’s intentions for that work.

o Context in which the work should be understood.

o Relationship between form and content.

e Reasons artist chose the techniques and processes present in the work.

o How the techniques, processes, and visual forms support the meaning and concepts in the work.
¢ Reference and influences—ideas, cultural factors, other artists or artistic movements.

Look at Other Examples

Before writing an artist statement, it is a good idea to read the statements of other artists and compare them to the visual work. How
well does their artist statement reflect the work? Does reading the artist statement deepen your understanding and appreciation of
the work? What specifically do you think the statement does well? What specifically do you think is not so strong?

How to write an Artist Statement

Before writing your artist statement, think about the audience you are writing for and what you want your statement to say about
you as an artist.

To help draft your artist statement, consider the following questions:

e What themes are present in your work? What ideas are you engaging with? What is the intended conceptual meaning?

o What is the subject of your work? How does the visual imagery relate to the overall concept or theme?

o What is the process (i.e., techniques, materials) for creating your work? How do the process and/or material choices relate to the
overall concept or theme?

o What is the context in which your work should be understood? What is the creative or scholarly conversation you are
participating in? What artists, thinkers, and theories influence and inspire your work?

o Why did you make this work? Why should the audience care about it? Why is the work important to you?

Activity: Draft your Artist Statement
Brainstorm keywords associated with your project and write them on note cards or sticky notes.
Group your notes according to the artist statement elements:

e Themes
e Content
e Form

@ 0 https://human.libretexts.org/@go/page/279433
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o Influences

Write an opening sentence for your artist statement. Think about the first line in the story of your journey as an artist. This is your
opportunity to grab your audience’s attention.

Then, use your notes to free-write a draft of your artist statement.

X Tips for Writing your Artist Statement

o Grab the reader’s attention with the first sentence.
o Be succinct.

o Give a hint about the why of the work.

o Use the first person (I, me, my).

e Avoid art jargon.

Copyediting and Proofreading

Remember that the artist statement is a public, textual representation of you and your work. Therefore, it is important to revise for
clarity, edit for proper grammar, and proofread for a final draft. Try reading your statement out loud to yourself. It is a good idea to

have someone who is not an artist read your statement, as they can help you avoid art jargon. Also consider visiting the University
Writing Center.

Activity: In-Class Peer Review
1. Draft a complete artist statement.
2. Bring it to class and exchange it with other students.

Questions for Peer Review:

1. Does the artist discuss the main topics of an artist's statement?
o Theme
o Content
o Form
2. Influences
3. What topics are referenced in the artist's statement that might need further research or explanation?
4. Are there questions you have about the artist's work that are not answered in the artist's statement?

5.1: Appendix A- Artist Statements is shared under a CC BY license and was authored, remixed, and/or curated by LibreTexts.
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5.2: Appendix B- Critiques, or CRITs

Critiques are a common pedagogical tool and discussion strategy used in studio art education where the artist presents their work to
an audience for feedback and/or assessment. Critiques are a form of peer review that provide an opportunity to brainstorm ideas,
share perspectives, and help participants learn and grow as artists.

Although the purpose of critique is to improve the work, for many students, the word suggests criticism or negative judgement. It
can be challenging to separate oneself or one’s intentions from the work itself, which is especially true when the artwork engages
with personal topics or experiences.

So instead of “critiques,” think of it as CRITs.

o Community

¢ Reading and Responding
¢ Images and Ideas

o Together

CRIT focuses on the opportunity to learn from and with your community, how they read the work, successful elements, and areas
that may be harder to respond to. It is a way to get additional insight into technique and leverage the knowledge and experiences of
others. It is also an opportunity to learn about other artists you might be in conversation with, as instructors and other students often
share recommendations of artists to research. The goal of CRITs is to “unlock students’ potential by focusing on their talents”
(ACRL, 2018).

Presenting your Work for CRIT

Successful CRITs require preparation. If this is a final crit (as opposed to a more informal crit that takes place during work-in-
progress), take some time to select the work that you feel is the most resolved and successful. If you don’t want to talk about a
particular work, don’t bring it to class.

Additional Considerations

How will you arrange the artwork? Will the work be hung in straight line, a grid, on a table, in book format? Remember that how
the work is presented contributes to how the work is interpreted. Will you include an artist statement and titles? An artist statement
and titles provide context for the work. Is additional context important in understanding the work?

Will you introduce the work to give context or background information that would help the community understand the intention or
meaning of the work? Or will you ask the community for a “cold read,” viewing the work without an introduction or context.

Prepare for questions from the community by considering the following:

e What was your process?

o What concepts, research, or experiences informed the work?

o What effect do you want this work to have on the viewer?

o What did you struggle with?

o What did you learn from this project? Write down specific questions you have about the work that you would like the
community to respond to or provide feedback on.

During the CRIT, ask a friend to take notes for you as it can be challenging to stay focused and present in the conversation while
trying to record comments.

Remember that CRITs are an opportunity for you to practice speaking about your work. While it is normal to feel anxious about
presenting in front of people, the more you do it, the easier it gets. The goal of the exercise is to help you align the intentions for the
work with the audience’s interpretation, so focus on the feedback that will help you grow as an artist and disregard comments that
don’t feel like they apply to you. And remember to breathe!

Participating in the CRIT of the Work of Others

Significantly, the CRIT process relies on active participation; critique is about both giving and receiving feedback. Using “asset
framing”!
each other’s work, make notes about the following considerations:

as an approach to the critique practice helps focus the discussion on constructive, actionable feedback. As you look at

Assets
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o What are the strengths of the work?
o What elements of the work are successful, engaging, exciting?
o How does the work align with or express the artist’s intentions?

Challenges

o What areas could the artist develop further?
o How might the artist revise, rethink, or rework the piece?
o What techniques might the artist try to refine?

Solutions or Opportunities

o Are there other techniques the artist might consider trying?
o Are there other artists they might consider looking at?
o Are there topics the artist might consider researching further?

Finally, remember to speak up. The worst CRITs are the ones where no one talks.
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Adobe Bridge | A free digital asset management
app that allows you to organize, select the individual
images to import into image editing software, and
rename or export images.

Adobe Camera Raw | Software that lets you
import and enhance raw images.

Ambient light | Any light that is available in a
scene. It can be natural or artificial.

Ambient lighting | Overall brightness of a scene.

Aperture | Also known as “f-stop,” it is the opening
in the camera lens that allows light to be recorded on
the image sensor. It controls the depth of field and the
intensity or amount of light that reaches the image
sensor. A wide aperture (low f-stop) lets in more light,
and a narrow aperture (high f-stop) restricts it.

Artificial light | The light that comes from artificial
sources.

Autofocus | When the camera sharpens the image
automatically.

Back light | Type of third light in a three-light setup
that separates the tones and subject from the
background by adding depth and creating a pleasing
glow or halo around the figure.

Bracketing | The intentional overexposure and
underexposure of an image by a photographer to
capture a wider range of information for your image.
This technique can capture details in highlights or
shadows that might be otherwise lost and can be
especially helpful during the editing process when you
have a scene with a great variance of tones, such as
backlit subjects, sunsets, night scenes, or landscapes
with dramatic clouds.

Calotype | Early photographic process developed by
William Henry Fox Talbot that included the creation of
a paper negative and technology that involved the
transformation of the negative to a positive image,
allowing for more than one copy of the picture.

Camera obscura | A device that contains a small
hole for light to pass through and projects an inverted
image of an external object.

CMYK color model | A subtractive color system
used in color printing that uses cyan, magenta, yellow,
and black inks to create colors.

Collodion method | Early photographic process
that involved fixing a substance known as gun cotton
onto a glass plate, allowing for shorter exposure time
than previous processes of three to five minutes and
producing a clearer image.

Color management | The coordination of color
across various devices from cameras, computers, and
editing software to printers and the various paper types
to ensure that the color and tones of your image are
reproduced accurately.

Color space | The range of colors shown in a photo.

Composition | Also known as the principles of
design. How the design elements are arranged to
produce a specific effect.

Contact sheet | A document that shows all the
images captured for a particular project.

Continuous lights | Also known as constant lights;
lights that stay on during the photo shoot.

Correct images | Images free from unrealistic color
casts, that have appropriate brightness in the mid-tones
with details in both highlights and shadows, and have
adequate contrast for the subject.

Daguerreotype | Early historic photographic
process developed by Louis Daguerre that significantly
reduced exposure time needed to create an image and
resulted in a lasting image.

Depth of field | The distance of focus or sharpness
between the closest and farthest objects in a
photograph, and is controlled by the aperture.

Destructive editing | Adjustment that permanently
affects the pixels in an image. These types of edits
cannot be undone once the file is saved and closed.

DNG | Stands for digital negative files. It is the most
universally used file format supported by Adobe

Exposure | The relationship between ISO, shutter
speed, and aperture that produces the right balance of
tones (or correct exposure) in an image. For any scene,
there is a correct exposure determined by the amount
of light available and the specific camera settings the
photographer chooses. However, correct exposure is
relative; you can adjust shutter speed, aperture, and
ISO to capture the image you envision.

Fill lights | The supporting light sources in a scene.

Focal length | Describes the optical capabilities of a
camera lens and is represented in millimeters.

Form | Also known as the elements of design. The
physical parts or visual components of a work. These
include line, shape, mass/volume, perspective, texture,
and color.

Golden ratio | The relationship of parts achieved
when the longer part divided by the smaller part is also
equal to the whole length divided by the longer part. It
is thought to provide the most harmonious and visually
pleasing proportions in art and architecture.

Hair light | Type of third light in a three-light setup
that separates the subject from the background, adding
dimension to the image.

High key lighting | Creates large white areas that
are light and bright with white and grey tones that can
translate to upbeat, youthful, or happy feelings.

Histogram | Feature in editing programs that shows
the tonal distribution of the image.

Image quality | The resolution of the image.

Image sensor | Medium for digital cameras that
records an image.

ISO | Stands for International Standard Organization.
It is the numerical rating that describes the image
sensor’s sensitivity to light. The ISO determines how
much light is needed for correct exposure.

Kelvin scale | Absolute temperature scale.

Key light | The main light on a subject and the most
powerful light in the scene.

Lens | Part of the camera that collects light from an
object and focuses it through to the recording medium.

Light booth | Device designed to create the most
accurate light scenario for assessing prints.

Light direction | The relationship between the
camera, the subject, and the light, which will impact
where you add lights, and can be determined by the
highlights and shadows present.

Lighting | The intensity or quality of light, the effect
lights have on a particular scene.

Lights | The physical objects that emit light into the
world.

Low key lighting | Produces large dark areas that
can express somber, serious, or more formal tones.

Manual focus | Allows the photographer to control
the part of the image that is sharp.

Megapixel | Represents the camera’s resolution. 1
million pixels = 1 megapixel (MP).

Metering Mode | Setting that determines how the
light meter inside the camera measures exposure and
amount of light available in the scene.

Natural light | Light produced by the sun and
varies depending on the time of day and the season.

Nondestructive editing | Pixels are not discarded
or lost in the editing process and the quality of the
image is maintained.

One-light setup | Typically used to create a
dramatic portrait or still life and is usually a low key
lighting situation.

Quality of lighting | Determined by the light
source and whether or not it is modified. Described by
observing the highlights and shadows within a scene.

RGB color system | An additive color model that
uses red, green, and blue light to create colors.

Rule of thirds | The placement of the subject at the
intersection of the imaginary horizontal and vertical
lines that divide the image into three parts.

Shutter | The mechanism that controls the length of
time that the image sensor is exposed to light.

Shutter speed | The time measured in fractions of a
second that the shutter is opened, which determines the
length of time the light hits the image sensor.

Strobe lights | Lights that create short bursts of
light and are the most powerful lights with bright
intensity that most accurately replicate daylight in
color temperature.

Three-light setup | Consists of a key light, a fill
light, and one additional light best used to create a
more balanced image with more light.

Vantage point | The place from where you take a
photograph, or the photographer’s perspective. An
integral part of taking a photograph that can affect the
angles, composition, and narrative of the image.

White balance | The camera function that matches
the temperature of light in a scene with the color
recorded on the image sensor. Correct white balance
produces a more accurate representation of color
within an image.

Workflow | A sequence of steps needed to complete
a project.
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